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1 Getting Started

OmniSense Analysis User Guide

Click on the image to jump to the relevant introduction 

Graph Display Importing Logs Fitness Testing Reports

New Features
 
How to use this Guide
 
You are not connected to the internet - this is a local offline html document

1.1 Contact Zephyr

Contacts 

Mail: Zephyr Technology Corp.  1 Annapolis St., Suite 200, Annapolis MD 21401
USA

Email: support@zephyrtech.zendesk.com 
sales@zephyranywhere.com 

Web: www.zephyranywhere.com 
Phone: (+1) 443-569-3603
Fax: (+1) 443-926-9402

Zephyr Technology is a Division of Medtronic.

The information in this document is believed to be accurate in all respects at the time of publication but
is  subject  to  change  without  notice.  Zephyr™  Technology  assumes  no  responsibility  for  errors  or
omissions,  and  disclaims  responsibility  for  any  consequences  resulting  from  the  use  of  information
included  herein.  Additionally,  Zephyr™  Technology  assumes  no  responsibility  for  the  functioning  of
undescribed features or parameters. Zephyr™ Technology does not assume any liability  arising out of
the application or use of any product, and specifically  disclaims any and all  liability,  including  without
limitation  consequential  or  incidental  damages.  Zephyr™  Technology  products  are  not  designed,
intended or authorized for use in applications intended to support or sustain life, or for any application
in which the failure of the Zephyr™ Technology product could create a situation where personal injury
or  death  may  occur.  Should  Buyer  purchase  or  use  Zephyr™  Technology  products  for  any  such
unintended or unauthorized application, Buyer shall indemnify  and hold Zephyr™ Technology harmless
against all claims and damages.

1.2 New Features

OmniSense 4.1 NovemberApril 2016
Logging Improvements to the BioModule firmware have greatly reduced log 

mailto:support@zephyrtech.zendesk.com
mailto:sales@zephyranywhere.com
http://www.zephyranywhere.com


 12

© 2016 Zephyr Technology

download times

OmniSense Live · Miscellaneous minor bug fixes and improvements
· An Android/iPhone Readiness application which will receive data

from an at-home orthostatic test and email the results to a
recipient

BioHarness Module
Firmware Version

BioModule 3.0 9800.0153 (BT only)      BioHarness3_v1.5.0.0_1G
BioModule 3.0 9800.0189v6-v9g (BT + ECHO)
BioHarness3_v1.5.0.0_2G 
BioModule 3.0 9800.0189v9k (BT + ECHO + BLE)
BioHarness3_v1.5.0.0_3G

OmniSense 4.0 November 2015
Google Maps Maps will display if GPS devices are used. An internet connection is

required for initial map download. Each subject displayed will be
indicated by position and a colored snail trail with location heat map
& distance markers

Altitude Zones For GPS visualization

Parameter List The expanded parameter list is now reorganized and divided into
section which can be expanded or contracted

Accelerometery
Variables

A variety of new data variables are available from accelerometry
data, updated once per 1 / 2.5 / 5 second epoch. These have been
incoporated into the Summary Data Packet, and an Enhanced
Summary Log Format

Readiness Test
Analysis

Automated Analysis of orthostatic test data, coupled with a user
survey to give a 1 - 10 Readiness indication

Markers Markers can now be added and managed in sessions

Data Filter Wizard Time data can now be filtered according to its value, or conditional
on other parameter values. Filtered data can be saved as a
separate session.

Merge Sessions Sessions can now be merged

Session Timestamps Can now be edited

Bar graph vertical
scales

Configurable

Variables Categorized for easier management

Filter Session Default Start and End Date and Time now configurable

OmniSense Live · Two new ECHO modes to support up to 20 subject at 1 second
data rate, or up to 100 subjects at 5 second data rate. Default
remains at up to 50 subjects at 2.5 second data rate.

· Google Map display
· Altitude Zone display
· Accelerometry Variables
· Audio Workout Support
· QStarz BT1300ST compact GPS now supported

BioHarness Module
Firmware Version

BioModule 3.0 9800.0153 (BT only)      BioHarness3_v1.4.12.0_1G
BioModule 3.0 9800.0189v6-v9g (BT + ECHO)
BioHarness3_v1.4.12.0_2G 
BioModule 3.0 9800.0189v9k (BT + ECHO + BLE)
BioHarness3_v1.4.12.0_3G

BioHarness Module
Log Format

New logging formats incorporating additional accelerometer data
· Enhanced Summary
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· Enhanced Summary + Waveform
· Enhanced Summary + Development

OmniSense 3.9.6 January 2015
Log Download by
Bluetooth

Logs will be downloaded over Bluetooth by the Zephyr Downloader,
from devices which are in the OmniSense database, and are
powered on. Thus all 50 BioModules in the PSM Training system case
may have logs downloaded automatically with no user input after
starting.

Impact Angle Now measured in degrees instead of radians in the Pro Impact
Report

Delete Team/Subject A right click in the Select Session panel will allow you to delete a
team or subject and all associated data

Move subject A right click in the Select Session panel will allow you to move a
subject and all associated data to another team

Move session A  right click in the Select Session panel will allow you to move a
session to another subject

OmniSense Live · Rapid allocation to team, and assignment to BioModule and GPS
can now be performed automatically using a supported barcode
scanner

· Add GPS modules to the system by connecting over Bluetooth
· Pebble Watch support for latest version BioModule

BioHarness Module
Firmware Version

BioModule 3.0 9800.0153 (BT only)      BioHarness3_v1.4.5.0_1G
BioModule 3.0 9800.0189v6-v9g (BT + ECHO)
BioHarness3_v1.4.5.0_2G 
BioModule 3.0 9800.0189v9k (BT + ECHO + BLE)
BioHarness3_v1.4.5.0_3G

OmniSense 3.8.0 September 2014
Clock Bug In ECHO systems, device clocks are synchronized over-the-air

before recording of data starts. This eliminates a bug which showed
multiple subjects staring sessions at different times because their
BioModule internal clocks were not synchronized

Marker Bug The solution for the above bug also solves a problem where Markers
set in OmniSense Live did not show up in OmniSense Analysis

Subsessions Batch Subsessions are now supported. Time-based subsessions are
also supported

Session Archive Multiple sessions may now be removed from the OmniSense
database, and archived as a single ZSF file, to de-clutter old
sessions

OmniSense Live See OmniSense Live Help for details: 
· Physiological & Mechanical Intensity 0 - 10 ranges are now

configurable
· Motorola APX radios are now supported
· Session creation using Markers
· Training Zones are now configurable using either %HR@AT or %

HR
max

 as zone limits.

· Training Thresholds can now be set - preset lower limits for
Physiological, Mechanical & Training Loads, with an indication they
have been achieved

BioHarness Module BioModule 3.0 9800.0153 (BT only)      BioHarness3_v1.3.27.0_1G
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Firmware Version BioModule 3.0 9800.0189 (BT + ECHO) BioHarness3_v1.3.27.0_2G 

OmniSense 3.7.15 October 2013
Bug fixes Various minor bug fixes as reported

Analysis Reports Support for Chinese language

Impact Processor
Tool

Now included in installer. Instructions added to Analysis Help file

Zephyr Config Tool A new multi-device version of the tool now supplied.  Users are
required to enter their name to start, and a log file of any
reconfigurations is created. Details in OmniSense Live Help.

Zephyr Firmware
Updater

A new multi-device version of the tool now supplied. Users are
required to enter their name to start, and a log file of any firmware
updates is created. Details in OmniSense Live Help.

Time in Training
Zone

A new summary graph has been added

OmniSense 3.7.8 April 2013
Minor Bug Fixes Fix to minor bugs as reported

Zephyr Downloader Now Supports Summary + GPS mode

OmniSense 3.7.0 January 2013
Windows 8 Support Database management and charting updates to fix Windows 8

support issue

Minor Bug Fixes Fix to minor bugs as reported

OmniSense 3.6.1 November 2012
Log Download
Support for more
than 50 devices

For large ECHO systems, more than 50 devices can be added to the
OmniSense database so that logs can be downloaded automatically.
Only the first 50 devices will be assigned ECHO Short addresses for
radio communication. Any further devices will have a null value for
the short address. They cannot be used for streaming data
communication by ECHO when thus configured, but can be used in
logging mode.

OmniSense 3.6.0 October 2012
Bug Fixes Various minor bug fixes

Help File (This file) Update of screen captures, index & omissions.

Default Filter Session
Calender Setting

This has been changed to start from 6 months prior to the current
date. It was previously 1 year prior.

OmniSense 3.5.1 October 2012
Graph Data Export Previously only to .csv file; .JPG, .PNG,.GIF, .TIF, .SVG, .PDF now

added

Reports The number of reports has been expanded - subsets of periodization
workout, training and GPS data are now available:
· Group Consolidated Summary
· Periodization
· Summary GPS
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· Summary Physiological
· Workout Compliance

Autopopulation of
reports

Context menu autopopulation of the legend and reports helps
streamline creating reports

OmniSense 3.4.18 September 2012
GPS Support New variables added:

Time Variables: Speed over Time, Distance Over Time
Summary Variables:Speed Summary, Time in Speed Zone, Distance
in Speed Zone, Total Distance Traveled

GPS Support External kml files can now be generated from sessions in the Select
Session tree which contain gps data. Right-click and use the
context menu.

OmniSense 3.4.5 July 2012
GPS Support The Zephyr Downloader can now download GPS data from a

BioHarness configured to work with a supported GPS device and
deposit data into the OmniSense database, as well as generate
external kml files

Known Issues
ISM Limitations OmniSense 3.x continues to support ISM devices, but users should

be aware that some data is generated in the device itself, or
relayed from an external Bluetooth sensor and if the ISM device
does not provide or support it, then the parameter will not be
available in OmniSense. In Analysis, unavailable parameters include:
Heart Rate Recovery (except from a fitness test analysis), Skin
Conductivity, Heart Rate Variation, Estimated Core Temperature,
Device Temperature, Breathing Rate amplitude/noise/confidence,
Jump and Dash Test parameters, SpO2, Blood Pressure , Heart Rate
Confidence, System Confidence, Galvanic Skin Response, Bluetooth
Link Quality, RSSI & Tx Power.

OmniSense 3.4.3 July 2012
Internal database
development

The OmniSense database can now store GPS data imported from a
BioHarness 3 log when the device has been used in conjunction with
a compatible Bluetooth GPS unit. Displaying the data in the Analysis
or live modules is still under development.

OmniSense 3.3.11 June 2012
Summary Variables Addition of a number of variables associated with the Summary data

packet

OmniSense 3.3.5 May 2012
Filter Session List The logic of the filter session pull downs has been improved

Intensity and Load New parameters for Physiological & Mechanical Load & Intensity
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replace the previous Effort & Exertion Score values. Training Load &
Intensity provide an average load & intensity for each session. 

Real & Elapsed Time Sessions can now be displayed against each other in real time.
Previously only elapsed time was available, starting all sessions at
00:00:00

DownLoader Tool This utility can now be used to import data from multiple BioHarness
modules simultaneously into the OmniSense database. It is accessed
from the Analysis toolbar.

1.3 Using This Guide

If using the Quick Links on the Getting Started page doesn't help, then the quickest way
to find information is to use the Index:

 
· Select the Index tab on the left-hand navigation panel. Use the Alphabet links to jump

to a letter heading - it's quicker than scrolling through the list.
· Use the Search tab for a specific word search if the Index doesn't provide an

appropriate reference

· Use the browser Back   button to retrace your path (Keyboard shortcut:  +
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 )
· If you have a suggestion to add to the index, email support@zephyrtech.zendesk.com 

Note that a HM2GO web server application will run while you are viewing this file, to
enable its viewing in Google Chrome browsers. 
You are not connected to the internet.

mailto:support@zephyrtech.zendesk.com
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2 Overview

 

1 Filter Session List
Use pulldowns to populate the Select
Session tree.

4 Graph / Report Panel
The graph - Time, Summary or
Readiness data, or display Reports

2 Select Session
Select Session by double clicking to
send to legend. Right-click any
session for multiple options

5 Map Display
Use map button to hide or move to a
separate Window, as map or satellite
view

3 Parameter List
Select any two parameters to display
on graph

6 Legend
List all sessions displayed on graph,
by color

 
Suggested task flow:
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2.1 Toolbar Buttons

Buttons are Blue when activated, grey when inactive (not disabled)
 

Display Time data – line graphs

Display Summary data – bar graphs

Populate the graph panel with the readiness display and associated buttons
for the selected session

Display the Preferences dialogue

Open the Impact Processor Tool

Import log data from a device(s), or a .zsf file exported from another
instance of Analysis

Refresh database – used when Live is running simultaneously with Analysis
module

Help – display this guide

Delete all vertical markers from the selected data session

Add a vertical marker to the selected data session

Set subsession – using cursor drag

Toggle between Map/Satellite view display as a panel in Analysis, as an
external window, or hidden. The session should contain GPS data.

Expand graph panel to full screen

Print

Clear all graph and legend entries

Display a dialogue to filter graphed data. Use any one parameter to exclude
others by adding zero values, or interpolating. If the Filter text is red, then
filters have been applied to the graphed data.

Export the graph data as a csv file, or a variety of image files.
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2.2 Preferences

The  toolbar button will display a dialogue giving access to a number of settings:
· General
· Intensity & Load
· Training Zones
· Speed Zones
· Altitude Zones
· Summary Graph
· Data Filters
· Readiness Weights

Note: changing any of the following preferences will change the corresponding settings in
OmniSense Live:
· Units (Imperial/Metric)
· Intensity & Load
· Training Zones
· Speed Zones

You may need to use the refresh data button to implement saved changes.

2.2.1 General

Display Units Switch between Imperial & Metric units. Will change the
corresponding preference in OmniSense Live

Session From / To Set the default period for session data to display in the Filter
Session List. Defaults to 14 days prior to today.
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2.2.2 Intensity & Load

· Physiological Intensity  is a measure of the effort made by the cardiovascular system,
reflected in Heart Rate

· Mechanical Intensity is a measure of the effort made by the musculoskeletal system,
reflected in accelerometer data

· Changing thresholds in Analysis will also change the same thresholds in OmniSense Live
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Physiological
Intensity
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Low Limit Below 50% of HR max the physiological intensity has a null (zero)
value

High Limit Between the lower and upper limit, physiological intensity is divided
into a 1 - 10 scale of even steps. For default values, each step is
5%, so HR of 50 - 54.9% scores 1, 55 - 59.9% scores 2 etc

Mechanical
Intensity

Low Limit Below 0.5 Peak G/epoch, mechanical intensity has a null (zero)
value. Motion somewhere between a walk and a run will generate
this value.

High Limit Between the lower and upper limit, mechanical intensity is divided
into a 1 - 10 scale of even steps. For default values, each step is
0.25g, so Peak G/epoch = 0.5 - 0.47 scores 1, 0.75 - 1.00 scores 2
etc

2.2.3 Training Zones

· Training Zones are heart rate zones and color the subject BioGauges in the Training tab
in OmniSense Live

· The zone range and color can be referenced to each subject's HRmax, or their HR@AT
as determined by a fitness Test

· Training Zones can be displayed as background shading in Time graphs, regardless of
whether heart rate is displayed

· Changing zone thresholds in Analysis will also change the same thresholds in OmniSense
Live
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2.2.4 Speed Zones

· Speed Zones can only be displayed for session gathered in OmniSense Live, or with
BioModules in logging mode, when configured with supported GPS devices.

· Speed Zones can be displayed as background shading in Time graphs, regardless of
whether speed is displayed

· Changing zone thresholds in Analysis will also change the same thresholds in OmniSense
Live

2.2.5 Altitude Zones

· Altitude Zones can only be displayed for session gathered in OmniSense Live, or with
BioModules in logging mode, when configured with supported GPS devices.
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· Altitude Zones can be displayed as background shading in Time graphs, regardless of
whether elevation is displayed
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2.2.6 Summary Graph

· Reset the vertical scale of the graphs as required.
· Default of automatic allows the vertical axis to auto-scale to the largest value

· Use the graph refresh button  to implement any saved changes

2.2.7 Data Filters

· Create filters and save in this dialogue - then turn on/off for a specific session using

the  button in the time data graph panel.
· Parameters which can be filtered are: HR, BR, Posture, Activity, Peak Accel, HRV &

Speed
· A new entry will be created automatically when the lowermost blank entry is edited
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Examples (shown)

HR Use Heart Rate confidence to interpolate HR, which will remove
unrealistic spikes & troughs in HR caused by noise in the ECG
circuit.

Speed Set null values for speeds which are unrealistically high (or low) due
to interruptions n satellite reception.
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2.2.8 Readiness Weights

· Assign weightings to each factor of the readiness calculation
· If each factor has a weighting of 10, they will all be equally weighted
· Objective factors are determined from analysis of orthostatic hypotension test data
· Subjective Factors are entered by submitting a survey in the Readiness panel
· The individual scores are used to calculate a final readiness score using
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3 Workflow

To use the module, use the panes in this order:
1. Filter Session List
2. Select Session to populate Legend
3.Choose Time or Summary Data
4. Select Parameters
5.Generate a Fitness Report

3.1 Filter Session List

· Use the filters to find particular sessions, select the sessions for display, and then
change the filter settings if you need to find other data for display with the first. 

· Plan ahead by naming specific sessions at the time of data collection (see OmniSense
Live Help > User  Preferences > Session Names)

 
Suggested filter order:
1. From: - (Defaults to the 6 months before current date). If the date of

sessions is known, adjust From and To to that date for fastest filtering
2. To: - (Defaults to current date). As above
3.Show Sessions - plan session names in Live make for easier filtering in Analysis
4. Teams - this reduces the number of people available in the People pull down
5. People - this reduces the number of entries in the Sessions and Subsessions

pull downs
6.Subsessions: - If you are systematically creating sub sessions to exclude

irrelevant data at the beginning and end of each session, and naming them
appropriately,
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  this will allow for fastest access to the most important data. 

3.2 Select Session Options

Populate Legend or Training Reports
To move a session to the Legend for display:
· Double click on a session or subsession to move it to the legend
· Left click and drag an individual session or subsession directly on to the legend
· Hold the Ctrl Key and left click multiple sessions, and then drag to legend (Shift + Select

does not select a sequence of sessions)

Teams

Permanently Delete Team Permanently delete the team, all members, and all associated
data

Subjects

Permanently Delete Permanently delete the subject and all associated data

Change Team To Move the subject and all associated data to another team.
Use this before deleting a team, if you want to retain the
subject and data. Create a        'holding' Team in Live if
necessary.

Sessions
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Rename Rename Session

Export to ZSF Create an external Zephyr Serial Format file, which can be
re-imported later, or imported into a separate instance of
OmniSense to transfer data between computers.

Export GPS data to a kml
file

Generate an external file for import into Google Earth. The file
will display location information, and also vital signs

Archive All Filtered Sessions
to ZSF

Remove all the filtered sessions from the database and save
them as a single archived file. A dialogue will display asking to
confirm the action. Use the Filter Session List panel to display
those you want to archive. Once removed, archived sessions
can be re-imported into the database using the Launch Log
Downloader button in the Analysis toolbar.
Use the From File option

Delete Permanently delete the session

Delete All Filtered Sessions Permanently delete all sessions displayed in the Select
Session tree. Use the Filter Session list panel to display only
those you want to delete.

Copy Sessions To > Import the session to Graph Legend or a Training Report
(report tab must be pre-selected)

Copy Subsessions To > As above

Create Subsession Display a subsession dialogue 

Move Session to Another
Person

Transfer the session to another subject

Merge Sessions Useful when data from a Live session is incomplete or
fragmented e.g. BioModule turned off and on again. Combine
two live sessions or a live and log data from the same session
to create a continuous data session.
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Change Time of Session Display a dialogue to allow reassignment of time stamp (all
components from year to seconds)

Save Filtered Session Save a copy of the filtered session.

3.3 Legend

Time Data
· Populate the legend by double-clicking on sessions in the Select Session tree
· Data sets on the graph are color-coded to match the legend

   The solid line indicates the first variable selected, chronologically. To reverse
the solid/dotted line indication, deselect both parameters in the Select

Variables pane, and reselect them in reverse order
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Use the Clear button  to remove all entries from the legend

Summary Data

3.4 Select a Parameter

Select a maximum of two parameters from the check boxes in the Variables panel.

Time Parameters Summary Parameters

Expand any node to see a full list Expand any node to see a full list
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If sessions exist in the Legend, then the graphs will populate automatically when the
check box is selected.

The first checkbox selected will display on the graph as
· a solid line in a time variable graph
· the leftmost bar on a summary graph

To remove a parameter from the graph
· Uncheck its check box to remove a single parameter

· Use the Clear button  to remove both parameters and remove all sessions from
the legend



Part 4
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4 Choose Time or Summary Data, or Readiness

Select graph type using the buttons provided:
· Time data - line graph showing raw data at 1 sec intervals
· Summary data - bar graph showing min/max/avg
· Readiness - a line graph for analyzing orthostatic test data, and buttons to

complete a readiness survey

4.1 Time Data Parameters

· Raw data is a line graph of the streaming data captured at 1/2.5/5 second intervals
depending on Radio Network ECHO setting in OmniSense Live. It is always 1 second for
log data.

· Two parameters may be displayed per subject.
· The first parameter selected displays as a solid line _______
· The second parameter selected displays as a dotted line - - - - 
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Raw Physiological

Heart Rate Beats per minute

Breathing Rate Breaths per minute

Skin Temperature Supported by BioHarness 2 only

Heart Rate Variability No data for 1st 300 beats of session - updated per second

Dependent Physiological

Estimated Core
Temperature

Determined by HR data - independently researched algorithm.
Not supported by BioHarness 2

Heart Rate Percent
HR displayed against background stratified at 65% and 85% of
subject's HR max (illustrated)

Heart Rate at AT
Recorded when subject crosses their breathing rate anaerobic
threshold

Heart Rate Recovery at
30sec

Recorded when HRR criteria are met

Heart Rate Recovery at
60sec

Recorded when HRR criteria are met

Heart Rate Recovery at
120sec

Recorded when HRR criteria are met

Heart Rate Recovery at
180sec

Recorded when HRR criteria are met

Accelerometry

Activity

VMU = 0.2~walking 0.8~jogging. At each 100Hz sampling
point, the three axial accelerometer values are combined to
give a single acceleration magnitude in g. VMU is the average
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value of this magnitude over a 1 second epoch

Posture
0°=vertical 90°=prone (lying face down) 180°=inverted -90°=
supine (lying face up)

Peak Acceleration
The largest acceleration magnitude - 3 axes combined - in
previous second, out of 100Hz samples. Max. dependent on
hardware version. 3.3g on older hardware; currently 8g

Accelerometry
Supported by PSM Direct Connect & Training 3.0 (ECHO)
systems only. 3-axis data displayed

Average Rate Force
Development

A measurement of explosive power, averaged over the
previous 10 steps, measured in Newton/s

Average Step Impulse
A measure of the efficiency of steps, i.e. how much energy is
expended during a step. Shorter (in duration) steps expend
less energy. Measured in Newtons.

Average Step Period Seconds - time duration of step

Flight Time
Milliseconds - time in the air for a detected jump event
(crouch/pause/jump)

Peak Magnitude Phi Degrees from vertical of force or impact during an epoch*

Peak Magnitude Theta Degress from horizontal of force or impact during an epoch*

Impulse Load
A cumulative measure of mechanical load - the sum of the
areas under the accelerometer magnitude curve for all
impulses, measured in Newtons

Walk Step Count

Cumulative count of walking steps. Steps, bounds and jumps
are distinguished by analysis of the direction of impulse,
magnitude of the impulse, and time interval from the previous
impulse.

Run Step Count Cumulative count of running steps

Bound Count Cumulative count of bounding steps

Jump Count Cumulative count of detected jumps

Minor Impact Count Cumulative count of minor impacts (3 to 7g peak)

Major Impact Count Cumulative count of major impacts (> 7g peak)

Workout Summary

Physiological Load Cumulative index of effort based on heart rate

Physiological Intensity Instantaneous index of effort based on heart rate

Mechanical Load Cumulative index of effort based on acceleration

Mechanical Intensity Instantaneous index of effort based on acceleration

Training Load Average of the above two

Training Intensity Average of the above two

Assessments

Treadmill Test Displays heart rate, breathing rate & activity level

Beep Test Displays heart rate, breathing rate & activity level

40 yard dash test Maximum acceleration value attained if dash event detected

Jump Test
Maximum vertical acceleration attained if jump event
detected

Jump Time in Air Measured in milliseconds

Jump Height Estimated maximum height attained if jump event detected, in
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meters

ROG Alert Status
Displayed as line in graph - additional checkbox above graph
can display as vertical banding superimposed on other
parameters

GPS/Accessory Input

Speed Over Time GPS data - speed vs time

Distance Over Time GPS data - accumulated distance vs time

Elevation Over Time GPS data - elevation vs time

Pulse Oximeter   Oxygen
Saturation (%)

Supported by PSM Direct Connect & PSM Responder only,
when a supported external SPO2 sensor has been assigned to
the subject

Blood Pressure
Supported by PSM Direct Connect & PSM Responder only,
when a supported external Blood  Pressure sensor has been
assigned to the subject

Aux ADC 1
For Zephyr internal use (any data observed represents circuit
noise)

Aux ADC 2 For Zephyr internal use

Aux ADC 3 For Zephyr internal use

Quality

Heart Rate Confidence
Expressed as %. Dependent upon wear detection, ECG
amplitude & ECG noise level

ECG Amplitude
Indicative only - represents an uncalibrated R-peak to S-
peak. Measured in Volts

ECG Noise
Indicative only - represents an uncalibrated amplitude of
noise between QRS complexes

Breathing Wave Amplitude

A metric extracted from the breathing detection algorithm -
used for internal development only. A large initial value rapidly
reduces. No inference on breathing depth can be made from
this data

Breathing Wave Noise N/a - 'Invalid' value always returned

Breathing Rate Confidence N/a - 'Invalid' value always returned

Troubleshooting

Device Internal
Temperature

Ambient temperature measured by a thermistor inside the
BioHarness

Battery Voltage
Device Battery level in volts. ~4.2V = fully charged, ~3.6V =
fully discharged

System Confidence Currently identical to HR Confidence

Galvanic Skin Response Not supported by BioHarness 3. Invalid value returned

Skin Conductivity Level
Indicative only for some BioHarness 2.0 versions. Not
supported by the BioHarness 3

Link Quality Bluetooth Link Quality. 0=Poor, 254=High, 255=Invalid

RSSI
Bluetooth Received Signal Strength Indication - -127 to +127
dB

TX Power Bluetooth Transmit Power. -30 to +20 dBm

* Epoch is 1 / 2.5 / 5 seconds, dependent on ECHO network setting.



 42

© 2016 Zephyr Technology

4.1.1 Time Data Graphs

· manually select 1 or 2 variables per
subject

·  left axis - 1st variable selected

· HR/BR/Activity if any Fitness Test
Selected

· right axis - 2nd variable selected

· HR/HRV/Activity/Posture if Readiness
selected

· a maximum of 16 subjects

Display the data values at the vertical cursor location.
Upper timestamp is elapsed time.
Lower timestamp is real time.

Choose between:
1. None 2. ROG Status 3. Training Zone 4. Speed Zone (GPS data) 5.
Positional Error (GPS data)

Display the time axis as
· Real Time - session data may not overlap
· Elapsed Time - all sessions start at 00:00:00

Delete all vertical markers from the session and subsessions

Add a vertical marker at the vertical cursor location

Create a subsession

Toggle display of Google Map/Satellite view for GPS data
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Display full screen

Display a Print dialogue

Filter data displayed according to its own or other parameter values.
The button text displays red if any filters are turned on. The will be
applied to any session displayed on the graph, but are temporary,
unless a filtered version of the session is saved.

Export the graph data in a variety of formats

4.2 Summary Data Parameters

Summary data is in bar chart form. Each bar is typically a maximum, minimum or average
value.

Raw Physiological

Heart Rate Beats per minute

Breathing Rate Breaths per minute

Skin Temperature Supported by BioHarness 2 only

Heart Rate Variability No data for 1st 300 beats of session - updated per second

Dependent Physiological

Estimated Core
Temperature

Determined by HR data - independently researched algorithm.
Not supported by BioHarness 2

Heart Rate Percent
HR displayed against background stratified at 65% and 85% of
subject's HR max (illustrated)

Heart Rate at AT
Recorded when subject crosses their breathing rate anaerobic
threshold

Heart Rate Recovery at
30sec

Recorded when HRR criteria are met

Heart Rate Recovery at Recorded when HRR criteria are met
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60sec

Heart Rate Recovery at
120sec

Recorded when HRR criteria are met

Heart Rate Recovery at
180sec

Recorded when HRR criteria are met

Accelerometry

Activity

VMU = 0.2~walking 0.8~jogging. At each 100Hz sampling
point, the three axial accelerometer values are combined to
give a single acceleration magnitude in g. VMU is the average
value of this magnitude over a 1 second epoch

Posture
0°=vertical 90°=prone (lying face down) 180°=inverted -90°=
supine (lying face up)

Peak Acceleration
The largest acceleration magnitude - 3 axes combined - in
previous second, out of 100Hz samples. Max. dependent on
hardware version. 3.3g on older hardware; currently 8g

Accelerometry g Force
Supported by PSM Direct Connect & Training 3.0 (ECHO)
systems only. 3-axis data displayed

Average Rate Force
Development

A measurement of explosive power, averaged over the
previous 10 steps, measured in Newton/s

Average Step Impulse
A measure of the efficiency of steps, i.e. how much energy is
expended during a step. Shorter (in duration) steps expend
less energy. Measured in Newtons.

Average Step Period Seconds - time duration of step

Flight Time
Milliseconds - time in the air for a detected jump event
(crouch/pause/jump)

Peak Magnitude Phi Degrees from vertical of force or impact during an epoch*

Peak Magnitude Theta Degress from horizontal of force or impact during an epoch*

Impulse Load
A cumulative measure of mechanical load - the sum of the
areas under the accelerometer magnitude curve for all
impulses, measured in Newtons

Walk Step Count

Cumulative count of walking steps. Steps, bounds and jumps
are distinguished by analysis of the direction of impulse,
magnitude of the impulse, and time interval from the previous
impulse.

Run Step Count Cumulative count of running steps

Bound Count Cumulative count of bounding steps

Jump Count Cumulative count of detected jumps

Minor Impacts Cumulative count of minor impacts (3 to 7g peak)

Major Impacts Cumulative count of major impacts (> 7g peak)

Workout Summary

Exercise Time Total Time active for session

Time in HR Zones
Horizontal striping on bar. The following scale is used for the
colors:
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Time in Training Zone

Horizontal striping on bar. Zone thresholds are configurable in 
Preferences.

Distance in speed zone

Horizontal striping on bar. Zone thresholds are configurable in 
Preferences.

Time in speed zone

Horizontal striping on bar. Zone thresholds are configurable in 
Preferences.

Calorie Calories burned. ACSM formula.

Physiological Load Cumulative index of effort based on heart rate

Physiological Intensity Instantaneous index of effort based on heart rate

Mechanical Load Cumulative index of effort based on acceleration

Mechanical Intensity Instantaneous index of effort based on acceleration

Training Load Average of the above two

Training Intensity Average of the above two

AT Heart Rate, breathing rate and time above AT threshold

Assessments

40 Yard Peak Acceleration Max/Min/Avg peak acceleration if a dash event is detected

Jump G Force Max/Min/Avg jump g force if a jump event is detected

Jump Time in Air
Max/Min/Avg time in air (milliseconds) if a jump event is
detected

Jump Height Max/Min/Avg jump height if a jump event is detected
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GPS/Accessory Input

Total Distance Traveled Total distance traveled

Speed GPS data - speed

Elevation GPS data - elevation

Pulse Oximeter 
Oxygen Saturation (%)

Supported by PSM Direct Connect & PSM Responder only,
when a supported external SPO2 sensor has been assigned to
the subject

Blood Pressure
Supported by PSM Direct Connect & PSM Responder only,
when a supported external Blood  Pressure sensor has been
assigned to the subject

Aux ADC 1 Not used

Aux ADC 2 Not used

Aux ADC 3 Not used

Quality

Heart Rate Confidence
Expressed as %. Dependent upon wear detection, ECG
amplitude & ECG noise level

ECG Amplitude
Indicative only - represents an uncalibrated R-peak to S-
peak. Measured in Volts

ECG Noise
Indicative only - represents an uncalibrated amplitude of
noise between QRS complexes

Breathing Wave Amplitude

A metric extracted from the breathing detection algorithm -
used for internal development only. A large initial value rapidly
reduces. No inference on breathing depth can be made from
this data

Breathing Wave Noise N/a - 'Invalid' value always returned

Breathing Rate Confidence N/a - 'Invalid' value always returned

Troubleshooting

Device Internal
Temperature

Ambient temperature measured by a thermistor inside the
BioHarness

Battery Voltage
Device Battery level in volts. ~4.2V = fully charged, ~3.6V =
fully discharged

System Confidence Currently identical to HR Confidence

Galvanic Skin Response
(GSR)

Not supported by BioHarness 3. Invalid value returned

Link Quality Bluetooth Link Quality. 0=Poor, 254=High, 255=Invalid

RSSI
Bluetooth Received Signal Strength Indication - -127 to +127
dB

TX Power Bluetooth Transmit Power. -30 to +20 dBm

Skin Conductance Level
Indicative only for some BioHarness 2.0 versions. Not
supported by the BioHarness 3

 

4.2.1 Summary Data Graphs

· manually select 1 or 2 variables per ·  a maximum of 16 subjects
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subject

· left axis - 1st variable selected (or
both if the units are the same e.g. Max &
Average Heart Rate)

· sub sessions cannot be created from a
summary graph

· right axis - 2nd variable selected · vertical axis can be autoscaled or set to
manual in Preferences

Toggle display of Google Map/Satellite view for GPS data

Display full screen

Display a Print dialogue

Filter data displayed according to its own or other parameter values.
The button text displays red if any filters are turned on. The will be
applied to any session displayed on the graph, but are temporary,
unless a filtered version of the session is saved.

Export the graph data in a variety of formats

 



Part 5
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5 Graph Display

Time Data Summary Data

Cursor Values
Zoom & Pan
Subsessions
Real/Elapsed Time
Full screen display
Heart Rate %
Heart Rate Confidence
Heart rate at AT
Heart Rate Recovery
Heart Rate Variability

5.1 Cursor Values

· In Time graphs (but not Summary), a movable vertical cursor is located against the left
hand axis.

· To move the cursor, hold down the left mouse button  and drag to the required
location.

· The data values for the topmost session in the legend will be displayed in the frame
above the graph:
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 Note that the HRR30 field in the example above has no entry at the current cursor
location. There is no applicable HRR value at that point. To display HRR values by cursor
location, the HRR30 parameter should be selected first when populating the graph. They
are indicated by the four vertical arrows.

There are two time entries at the current cursor location:
· 00:04:33 - the elapsed time within the session - the session start is adjusted to

00:00:00
· 13:44:08 - the real time from the session

5.2 Zoom and Pan

There are three mouse functions to Zoom In, Pan and Reset the graphs. Both axes rescale
automatically for each of these operations.

Zoom

Pan
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Reset

5.3 Add/Remove Markers

· Add markers to identify points of interest in data
· Markers remain when session is closed
· Markers are visible in graphic file exports, but not in data files such as .csv or .xls
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Add a custom marker at the vertical graph cursor location

Delete all custom markers from the session

5.4 Subsessions

Multiple Subsessions
Time-based Subsessions

Single Subsessions
If a data recording consists of a number of distinct activities, each activity may be used a
basis for a sub session:

A separate data set is created each time a subset is created. They can be renamed, but
are stored in the explorer panel as sub-nodes of the parent session.
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Multiple Subsessions
Subsessions can be created to remove extraneous data before and after comparative
fitness tests, such as three subjects taking part in a Beep test. First, display the data and
set the horizontal Axis to show real time.
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 Then make a subsession which excludes the before and after sections of the activity.
Three separate subsessions are created:

 The three subsessions can then be used as data for a Group Report

Time Based Subsessions
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Subsessions can be created using time criteria. 
Suggested workflow:
1.  If desired, use the Filter Session pulldowns to select those parent sessions you intend

to create subsessions from
2. Transfer the parent sessions to the graph legend by double-clicking them, or dragging

on to the legend
3.Select those parameters (e.g. Activity) which will allow you to see the part of the

parent session you intend to extract.
4. Select the Real Time radio button above the graph - this will match the parent sessions

in real time
5.Drag the graph cursor to the start of the section you intend to create as a subsession

and note the timestamp   

 

6.Drag the graph cursor to the end of the section you intend to create as a subsession
and note the timestamp
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7.Right-click on any subsession and select  'Create Sub Session' from the context menu
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8. In the dialogue, relabel the subsession name, enter the times you have noted as the
start and end of the section you intend to extract as a subsession, and select whether a
single subsession, or all filtered sessions

9. On selecting OK, a single or multiple subsessions will be created

5.5 Real/Elapsed Time

When displaying Time data on the graph, the default Time (horizontal) axis calibration is 
Elapsed time. This means all sessions start at 00:00:00, so they can be aligned with each
other, regardless of which day or hour the sessions were actually recorded.

Elapsed Time Real Time
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Two identical activity sessions, recorded 12
hours apart, can be compared easily

The same two sessions displayed in real
time do not overlap. A warning dialogue will
display when this happens.

Real time should be used to compare sessions which occurred at the same time. 

Below are two sessions from the same beep test where subject BioHarnesses were not
started at the same time - an offset can be seen when they are displayed in Elapsed Time
as the BioHarness modules were not started simultaneously.

Elapsed Time Real Time

An offset can be seen as the red data
starts slightly before the blue

In real time, data is now synchronized
exactly

 
When sessions are synchronized in real time, then multiple subsessions can easily be
created which remove all extraneous data before and after the area of interest, allowing
for more valid Group Fitness Reports

5.6 Using Live & Analysis Modules Simultaneously

The Analysis Module can be used at the same time as the Live module. Data which is
currently being recorded in Live can also be displayed in Analysis. Use the Data Refresh
button to update any graphs displaying data which is still being recorded.
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5.7 Full Screen Display

·  Zoom and Pan will work on the new window
· No vertical cursor

5.8 Filter Data

· Create filters to interpolate or make zero (null) sections of data according to their own
value, or that for another parameter

· Use the filter data button  to display a dialogue to manage filters. The button
text is red if any filter are active

· Any session displayed on the graph will have active filters applied
· Multiple filters can be applied to the same parameter
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Filter Variable Seven variables can be filtered:
HR, BR, Posture, Activity, Peak Accel, HRV, Speed

Threshold
Variable

The value of the threshold variable will control whether the filter is
applied or not

When Condition of threshold variable :
Greater than, Less Than, Equal To, Not Equal To

Value Value used with the 'When' condition. Units will be metric or imperial, as
set in Preferences

Action Should the filtered variable be interpolated, or made null? Which, depends
on requirements.

On/Off Turn the filter on or off. a filter set to ON applies to all sessions displayed
on the graphs. if any filter is ON, the button text displays as red 

To delete a filter, select on the left  and use the
Delete key on your keyboad

Examples:

Use heart rate confidence to filter heart rate and remove high HR values caused by ECG
noise, and interpolate - this will give more realistic values for calories burned, intensity
and load calculations

Set realistic upper limits for speed and set to null any values greater than these, caused
by poor GPS satellite reception.

· Data is filtered in the graph, but the raw data remains unfiltered in the OmniSense
database.

· To save the filtered data permanently as a separate session, right click the session in
the Select Session panel and select the Save Filtered Session option.
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5.9 GPS Distance & Speed

A BioHarness 3 may be manually configured to communicate with a supported Bluetooth
GPS device. If this is done, and the device configured to Log in Summary & Waveform log
format, then the GPS location and speed data can be accessed by importing the log data
into Analysis. Instructions for configuration can be found in  OmniSense Live  Help > GPS
Support.

Time Variables
Speed Over Time
Distance Over Time

Summary Variables
Speed Summary
Time in Speed Zone
Distance in Speed Zone
Total Distance Traveled

5.9.1 Speed Over Time

Speed Over Time is a Time Variable. It is only available from sessions created by importing
log data from a BioHarness 3 which has been manually configured to communicate with a
supported Bluetooth GPS device.
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1. Select session from Session Tree, and populate the Legend

2. Check the Speed Over Time box in the Select Time Variables pane

3. A line graph will display, showing speed vs time
   

5.9.2 Distance Over Time

Distance Over Time is a Time Variable. It is only available from sessions created by
importing log data from a BioHarness 3 which has been manually configured to
communicate with a supported Bluetooth GPS device.

1. Select session from Session Tree, and populate the Legend

2. Check the Speed Over Time box in the Select Time Variables pane

3. A line graph will display, showing distance vs time, which will always accumulate
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5.9.3 Speed Summary

Distance Over Time is a Summary Variable. It is only available from sessions created by
importing log data from a BioHarness 3 which has been manually configured to
communicate with a supported Bluetooth GPS device.

Speed Summary is a box plot. An explanation can be found at http://en.wikipedia.org/wiki/
Box_plot

1. Select session from Session Tree, and populate the Legend

2. Check the Speed Over Time box in the Select Summary Variables pane.

3. A line graph will display a box plot, as illustrated below. 
   Note that some whisker points (the crosses at the mean and various percentiles) may
be superimposed over each other if the speed distribution is compact enough.
   

http://en.wikipedia.org/wiki/Box_plot
http://en.wikipedia.org/wiki/Box_plot
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5.9.4 Time In Speed Zone

Time in Speed Zone is a Summary Variable. It is only available from sessions created by
importing log data from a BioHarness 3 which has been manually configured to
communicate with a supported Bluetooth GPS device.

1. Select session from Session Tree, and populate the Legend

2. Check the Speed Over Time box in the Select Summary Variables pane.

3. A histogram will display, as illustrated below. 
   Right-click on an individual zone to display the duration in hh:mm:ss the subject has
spent in any particular speed zone.
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5.9.5 Distance In Speed Zone

Distance in Speed Zone is a Summary Variable. It is only available from sessions created
by importing log data from a BioHarness 3 which has been manually configured to
communicate with a supported Bluetooth GPS device.

1. Select session from Session Tree, and populate the Legend

2. Check the Distance Over Time box in the Select Summary Variables pane.

3. A histogram will display, as illustrated below. 
   Right-click on an individual zone to display the distance in miles the subject has covered
in any particular speed zone.
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5.9.6 Total Distance Traveled

Total Distance Traveled is a Summary Variable. It is only available from sessions created
by importing log data from a BioHarness 3 which has been manually configured to
communicate with a supported Bluetooth GPS device.

1. Select session from Session Tree, and populate the Legend

2. Check the Total Distance Traveled box in the Select Summary Variables pane.

3. A histogram will display, as illustrated below. 
      



 68

© 2016 Zephyr Technology

5.10 Map Display

· Any data session containing location data provided by a supported GPS will now display
automatically on an optional map/satellite view

· An internet connection is required for initial map display

The  toolbar button toggles map display between an embedded panel, an
external window, and hidden

A map will display and scale automatically if the session contains valid
GPS data
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Use the pulldown on the map  to switch between map and
satellite view

Use the Map Settings button to show or hide the Snail Trail Panel

Left-click and drag the map with the mouse cursor to reposition as
needed

Use the + / - button to zoom the map as needed

Current location - the location on the map corresponding to the location
of the vertical cursor on the graph panel in the main Analysis screen

Full path - the full session path and direction traveled shown in color
corresponding to the legend and data trace on the time graph or summary
graph

5.10.1 Snail Trail

· The snail trail shows the immediate data history of a subject on the map or satellite
view

· One of eight parameters can be color-indicated on the trail behind the current (vertical
graph cursor) location on the map

· Click any where on a distance marker or the trail for a spot display of data
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Snail against a black background for clarity
· Full track path is colored to match the assigned color in the legend (red in this example)
· Distance markers show on snail trail only
· Snail trail coloring changes according to thresholds set on Settings panel
· Snail trail length is set in settings, and show most recent selected data values for

subject
· The heat map is an additional background to the snail trail. It changes from green

(shown) to red as a subject reutrns to or stays in the same location. E.g. if the subject
is stationary, their heat map will change to red if their location remains constant, or
returns repeatedly to the same spot.

The  toolbar button toggles map display between an embedded panel,
an external window, and hidden.

Use the Map Settings button to show or hide the snail trail settings
panel.

Parameter available for display on the snail trail.

Adjust thresholds for the chosen parameter to color snail trail
according to parameter values.

Snail trail width & opacity - adjust to suit required visibility of snail
trail. Width at leftmost = snail trail hidden.

Set snail trail duration - the time history of data prior to the current
location. Current location can be varied by moving the vertical graph
cursor on the time graph display

The 'heat map' indicates persistence in a location. It is an additional
background color surrounding the snail trail which changes from green
to red as a location becomes more persistent.

Distance markers will display (on the snail trail section only) as circles
corresponding to the legend color scheme, as show in the diagram
above.

Configure distance separation, width and opacity to suit.

Full path width & opacity - adjust to suit required visibility. Width at
leftmost = full path hidden.
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Save the current map settings. They will be used each time a map is
displayed.

Revert to default map settings.
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6 Readiness

· Readiness is a total indication of a subject's readiness for an activity within a training
program. 

· It is measured on a scale of 1 - 10.

· Access the Readiness components by using the  Readiness button in the toolbar.

1. Conduct an Orthostatic Test, and populate the legend with the data from the test.
2. Perform an automatic Orthostatic test analysis. This establishes the subject's resting

heart rate, standing heart rate, and resting heart rate variability.
3. Complete a subjective survey and save the results. You can retain the subject's existing

heart rate parameters, or update with those just measured.
4. Each component of the survey is given a weight factor and is used in the Readiness

calculation.
5. Save the subject's new Readiness calculation.
6. Retrieve subject's Readiness history to monitor their progress and readiness status.

Orthostatic Test
Analysis

Automatic Analysis of Orthostatic Test data to retrieve resting and
standing heart rate, and resting HRV

Readiness Survey Completion of subjective and objective factors to allow Zephyr's
readiness algorithm to calculate a score.

Readiness History Retrieval and display of a subject's readiness history from the
database and external files

Remote Survey Using the Zephyr Readiness Phone application:

1. A subject will use Zephyr's Readiness application to conduct a Readiness test at home,
and email the result to a chosen recipient.

2. The recipient will receive an email with a csv file attachment containing all information
needed to complete a Readiness survey and update the subject's data.

3. Locate a session for the subject and populate the graph legend with it. This need not
be a Readiness session. Any session for that subject is enough to ensure that the
correct subject's Readiness History is updated.

4. Select the Readiness button on the toolbar.
5. Select the Survey button to display the survey dialogue.
6. Enter the survey data as received in the email attachment.
7. Save the survey results.

6.1 Orthostatic Test Analysis

Carry out an orthostatic hypotension test, using OmniSense Live to capture the data, or
by logging data in the BioModule and importing into Analysis. A Zephyr Android application
is under development which will allow a subject to carry out the test at home. The data
will be analyzed and automatically emailed to a chosen recipient.

1. Locate the test data in the select session panel and load it into the legend.
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2. Select the  Readiness button from the toolbar and check the Readiness Calculation

box  in the parameter list panel

3. Four parameters will display
   

Heart Rate (Red) Will reach a settled value during the resting component. and
increase when the subject stands

Heart Rate
Variability

(Blue) Will be a zero value initially, as HRV takes 300 beats (~5 minutes)
to be calculated

Activity (Black) Will register a spike when the subject moves from the resting to
standing positions

Posture (Green) Will indicate the transition from resting to standing

4. Select the  button to analyze the data.
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5. Markers will indicate Resting HR and Resting HRV at the end of the resting phase, and
Standing HR approximately 15 seconds after the subject is standing.

6. The two markers can be adjusted manually by positioning the vertical graph cursor at

the locations required and using the  and  buttons to update the
acquired values.

7. Select the  button to display a dialogue containing the above values,
and a survey of subjective questions for the subject to complete, to allow calculation of a
Readiness value.

6.2 Readiness Survey

· Select the  toolbar button to display the Readiness panel, and then the

 button to display the survey dialogue.
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· The dialogue will be populated with the results of the current orthostatic hypotension
test analysis, and the last saved value in the database.

· Use the checkboxes to update HR Resting & Standing, and HRV if needed. The new
value will display in red.

· Values must be entered for the subject (shown blank above) for the rest of the survey,
to calculate a more accurate Readiness metric.

Training Load 0 - 10 subjective estimate of average training load for previous 10 days

Training
Intensity

0 - 10 subjective estimate of average training intensity for previous 10
days

Sleep Quality 0 - 10 subjective score for previous night only

Overall Stress 0 = No stress, 10 = Completely stressful

Current Stress 0 = No stress, 10 = Completely stressful

Eating Habits 0 = Poor, 10 = Optimal

Hydration 0 = dehydrated, 10 = hydrated

Injury 0 = injury free, 10 = unable to perform

· All of the above values will be used in the Readiness algorithm to arrive at a final
calculation. 

· The Readiness Score is updated as values are entered.
· Weighting of the components can be adjusted in the Preferences dialogue.
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· Select  to save the final score to the database.

6.3 Readiness History

To display a history of Readiness metrics, including Orthostatic Test Analyses and Survey
results:
1. Select the Readiness pane using the toolbar button

    
2. Set the From and To date range in the Filter Session panel to cover the desired history
range

    
3. Select the Readiness Calculation checkbox in the Readiness parameter list

    
4. Select the Import History button (optional) to import Survey Results stored in an
external file

    
5. Select the Import button on the Select A Subject dialogue

    
6.  Browse to locate and select the required external survey file:
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7.  Confirm the selected data details

    
8.  Populate the Legend with at least one session, if an orthostatic test session is not
already there. [Any session will be adequate to display graph details]

    
9. Select any two Readiness metrics for display

   
10. The graph will populate with the Readiness History. Adjust the From and To settings in
the Filter Session list at any time.
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7 Parameters

Acceleration
Activity Level
Average Force Development Rate
Average Step Period
Average Step Impulse
Battery Level
Blood Pressure
Bound Count
Breathing Rate
Breathing Rate @ AT
Calories Burned
Distance Traveled
Elevation
Estimated Core Temperature
Explosiveness
Heart Rate
Heart Rate @ AT
Heart Rate Confidence
Heart Rate as % of HRmax
Heart Rate Maximum
Heart Rate Recovery
Heart Rate Resting
Heart Rate Standing
Heart Rate Variability
Heart Rate Variability (Resting)
Height
Impact
Impact Peak Magnitude Phi & Theta
Impulse Load
Intensity & Load
Jump
Jump Count
Location
Major Impact Count
Mechanical Intensity
Mechanical Load
Posture
ROG Subject Status
Run Step Count
Saturated Blood Oxygen Level
Signal Strength
Speed
Time in Heart Rate Zones
Training Intensity
Training Load
Walk Step Count
Weight
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7.1 Acceleration

Acceleration Lateral, Sagittal & vertical acceleration

OmniSense Live Accel Side Panel

OmniSense Analysis Time graphs 

Log Data Summary & Waveform, Enhanced Summary & Waveform
recorded as raw bits

Units g 

Range -8g - +8g

Reporting Frequency 100 Hz

Notes · Available from data gather on Bluetooth & ECHO radio network
systems

· Axis orientation - automatic if BioModule is configured for the
correct garment type

· Vertical data will show 1g gravitational offset
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7.2 Activity Level

Activity Level Measure of mechanical activity

OmniSense Live Subject BioGauge

OmniSense Analysis Time & Summary graphs, all Reports

Log Data All Formats 

Units VMU (Velocity magnitude units, measured in g)

Range 0 - 16g

Reporting frequency 1Hz

Notes · Walking equivalent activity > 0.2 VMU, running equivalent
activity > 0.8 VMU

Formula VMU = SQRT( x2 + y2 + z2) where x, y & z are the averages of
the three axial acceleration magnitudes over the previous 1
second epoch, sampled at 100Hz

 

7.3 Average Force Development Rate

Average Force
Development Rate

Measure of explosive power.  

OmniSense Live Subject BioGauge

OmniSense Analysis Time & Summary graphs, Pro Impact Report

Log Data Enhanced log formats

Units Newtons per second

Range 0 - 16g

Reporting Frequency 1Hz
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Notes · The gradient of the accelerometer magnitude (the steepness
of the curve) during initiation of an impulse.

· Averaged for the previous 10 steps, and zero if no steps
detected for 5 seconds

· Available OmniSense 4.0 and later

7.4 Average Step Period

Average Step Period Time duration of a step  

OmniSense Live Subject BioGauge

OmniSense Analysis Time & Summary graphs, Pro Impact Report

Log Data Enhanced log formats

Units Seconds

Range 0 - 1023

Reporting Frequency 1Hz

Notes · Averaged for the previous 10 steps, and zero if no steps
detected for 5 seconds

· Available OmniSense 4.0 and later

7.5 Average Step Impulse

Average Step Impulse Area under the accelerometer magnitude curve for a detected
step

OmniSense Live Subject BioGauge

OmniSense Analysis Time & Summary graphs, Pro Impact Report

Log Data Enhanced log formats

Units Newton Seconds

Range 0 - 1023

Reporting Frequency 1Hz

Notes · A measure of the efficiency of steps i.e. how much energy is
expended during a step. Shorter (in duration) steps expend
less energy.

· Averaged for the previous 10 steps, and zero if no steps
detected for 5 seconds

· Available OmniSense 4.0 and later

7.6 Battery Level

Battery Level Subject BioModule battery level

OmniSense Live Battery icon in subject BioGauge

OmniSense Analysis Time graphs

Log Data All log formats

Units Volts

Range 3.5 - 4.5

Reporting Frequency 1Hz

Notes · Fully charged battery voltage ~4.2V
· Fully discharged battery voltage ~3.6V
· The BioModule processor powers off the device at ~3.6V to

prevent chemical degradation to the battery
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7.7  Blood Pressure

Blood Pressure BP measured from a supported blood pressure cuff. Bluetooth
Radio Network type only

OmniSense Live Subject BioGauge, Sensors side tab

OmniSense Analysis Time graphs

Log Data Not logged in BioModule

Units mmHg

Range 20 -280

Reporting Frequency Default 5 minutes. Set in Live Preferences

Notes · Sensor must be added by Bluetooth to the system
· Pressure readings are relayed direct to the host PC by

Bluetooth

7.8 Bound Count

Bound Count Cumulative count of detected bounds

OmniSense Live Subject BioGauge

OmniSense Analysis Time and Summary graphs, Pro Impact Report

Log Data Enhanced log formats

Units Count

Range 0 - 1023

Reporting Frequency 1Hz

Notes · distinct from a step or a jump by the time in air between
adjacent steps.

· available from OmniSense 4.0 and later
· reset when the BioModule is power cycled

7.9 Breathing Rate

Breathing Rate Also respiration rate

OmniSense Live Subject BioGauge

OmniSense Analysis Time and Summary graphs, reports

Log Data All log formats

Units Breaths per minute

Range 4 - 70

Reporting Frequency 1Hz

Notes · breathing is detected by a pressure sensor in the strap which
detects torso expansion and contraction due to breathing.

· Several breaths cycles are necessary for initial breathing rate
to stabilize (15 - 45 seconds)

· spontaneous adjustment of strap tension or location, or
abrupt changes in posture, talking, coughing etc may cause
changes in the range of pressure detected by the strap which
produce temporary artifacts (peaks or troughs) in breathing
rate indication which should be anticipated and potentially
ignored when analyzing data

· BioHarness side strap rear showing location of the breathing
pressure sensor

· The strap should be located with the BioHarness device
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located under or slightly to the rear of the left armpit
· This places the pressure sensor at the apex of rib curvature

on the torso, allowing for optimal pressure variation as the
subject breathes.
· Regular manual palpitation of the breathing sensor can be
used to check whether a sensor is functioning correctly. Use

gentle pressure to simulate breathing cycles

7.10 Breathing Rate at Anaerobic Threshold

Breathing Rate at
Anearobic Threshold
(AT)

This is a fixed, saved value for any given subject

OmniSense Live Saved in database, listed in Subject Details

OmniSense Analysis Reports

Log Data No

Units Breaths per minute

Range

Reporting Frequency N/A

Notes · Value can be manually entered in subject details screen
· Value can be saved as a result of analysis of data from a 

Fitness Test

7.11  Calories Burned

Calories Burned Cumulative estimation of calories burned during a session

OmniSense Live Subject BioGauge

OmniSense Analysis Summary Graphs, Reports

Log Data No

Units Calories

Range

Reporting Frequency 1 Hz

Notes · A heart rate based calculation

  

where Cal
e
 

= Gender * (-55.0969 + (0.6309 * HR) + (0.1988 * wt) +
(0.2017 * age))
    + (1 - Gender) * (-20.4022 + (0.4472 * HR) - (0.1263 * wt)
+ (0.074 * age))

HR = average HR for epoch (1 second)
wt = subject weight in Kg
age = subject age in years
Gender = 1 for male, 0 for female
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7.12 Distance Traveled

Distance Traveled GPS distance traveled since start of session

OmniSense Live Subject BioGauge

OmniSense Analysis Time and Summary graphs, Reports

Log Data Waveform or Development formats only

Units Miles or Kilometers, configured in Preferences

Range 0 - 

Reporting Frequency 1 Hz

Notes · Data gathered by a supported GPS device, and relayed to
BioModule

· BioModule must be configured to log in Summary & Waveform
or Enhanced Summary and Waveform format using Zephyr
Config Tool

7.13 Elevation

Elevation GPS elevation

OmniSense Live Subject BioGauge

OmniSense Analysis Time and Summary graphs, Reports

Log Data Waveform or Development formats only

Units Feet or meters, configured in Preferences

Range 0 - 

Reporting Frequency 1 Hz

Notes · Data gathered by a supported GPS device, and relayed to
BioModule

· BioModule must be configured to log in standard or Enhanced
Summary and Waveform or Summary and Development format
using Zephyr Config Tool

7.14 Estimated Core Temperature

Estimated Core
Temperature

Subject Core Temperature (estimation)

OmniSense Live Subject BioGauge

OmniSense Analysis Time and Summary graphs, Reports

Log Data Summary or Enhanced Summary formats

Units Degrees Fahrenheit or Celsius, configured in Preferences

Range 33 - 41 Degrees C 

Reporting Frequency 1 Hz

Notes · A heart rate based calculation
· Search for 'Estimation of Human Internal Temperature from

Wearable Physiological Sensors' by Buller, Tharion, Hoyt &
Jenkins to see a paper describing this work.
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7.15 Explosiveness

Explosiveness Peak g detected during a dash event

OmniSense Live Subject BioGauge (displayed as 'Dash')

OmniSense Analysis Time and Summary graphs, Reports

Log Data N/A

Units g

Range ~ 6 - 11g

Reporting Frequency Per dash event

Notes · Calculated automatically if a Dash Event is detected

7.16 Heart Rate

Heart Rate Heart Rate

OmniSense Live Subject BioGauge, details panel

OmniSense Analysis Time and Summary graphs, reports

Log Data All formats

Units Beats per minute

Range 0 - 240

Reporting Frequency 1Hz

Notes · Heart Rate is determined from analysis of 250Hz ECG data

7.17 Heart Rate @ Anaerobic Threshold (AT) %

Heart Rate @ AT % Heart Rate as percentage point of  HR at anaerobic threshold

OmniSense Live Subject BioGauge, details panel

OmniSense Analysis Time & Summary graphs, Reports

Log Data N/A

Units Beats per minute

Range

Reporting Frequency 1Hz

Notes · HR @ AT is a fixed saved value for each subject, in the
OmniSense database

· Can be entered manually is subject details screen in
OmniSense Live

· Can be saved automatically in OmniSense Analysis as a result
of analysis of a Fitness Test

· HR@AT is typically 80 - 85% of HRmax, and is used as a
reference point in some training strategies. 

Zephyr’s interpretation of AT is the second ventilatory threshold, which is related to the
anaerobic threshold. This is indicated by a marked increase in breathing rate under
exertion, as a subject nears their maximum heart rate.

Each subject has a Breathing Rate at AT value stored against their details in the
OmniSense database. It can be changed in two ways:

· Return to the Live Module, and edit the subject’s details directly in the Setup > Subject
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screen

· Conduct a Fitness Test and update the subject’s details by  analyzing the test data

During an active session, a subject’s breathing rate may cross this threshold a number of
times. The heart rate at AT value is updated on the display (top right corner) if the
breathing rate stays above the AT threshold for more than 10 seconds, and this series of
HR values can be displayed as a time graph

7.18 Heart Rate Confidence

Heart Rate Confidence DEgree of validity of heart rate value, as a %

OmniSense Live Subject BioGauge, details panel

OmniSense Analysis Time & Summary graphs

Log Data Summary and Enhanced Summary formats

Units %

Range 0 - 100

Reporting Frequency 1Hz

Notes An algorithm calculates the value, which takes into account:
· ECG amplitude
· ECG noise (and hence signal-to-noise-ratio, when combined

with amplitude)
· Worn detection. This is also dependent on ECG amplitude for

the BioHarness 3, or impedance for the BioHarness 2 
· 100% indicates full confidence in the indicated heart rate

value. 
· Below ~ 25%, HR is not considered to be valid - the degree of

noise in the signal will generate erroneous values - normally
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higher than expected

The above data show three scenarios:
· strap worn normally
· strap deliberately dragged against skin with dry ECG sensor pads. This creates excessive

ECG signal noise
· strap removed completely

ECG noise is indicated by the blue trace. It is very evident that as ECG noise increases,
then HR Confidence reduces, and vice versa.

7.19 Heart Rate Maximum (% of)

Heart Rate Maximum Heart Rate displayed as a % of subject's maximum heart rate

OmniSense Live Subject BioGauge, details panel

OmniSense Analysis Time and Summary graphs, reports

Log Data

Units %

Range 0 - 100+

Reporting Frequency 1Hz

Notes · Maximum heart rate is stored in the OmniSense database by
editing the subject physiological parameters, or as part of
analysis of ramped fitness test data using the OmniSense
Analysis module.

· A value greater than 100% is possible if the stored HR
max

 for a

subject is inaccurate
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Heart Rate is displayed over a stratified background indicating
· 0 - 64% HR

max

· 65 - 84% HR
max

· 85 - 100% HR
max

7.20 Heart Rate Maximum

Heart Rate Maximum Subject's heart rate maximum, saved in OmniSense database

OmniSense Live Subject Details

OmniSense Analysis Reports (as Peak HR)

Log Data N/A

Units Beats per minute

Range 0 - 240

Reporting Frequency N/A

Notes A fixed value saved in the OmniSense database. 
· when a new subject is added it is auto-calculated but can be

immediately edited
· it is updated automatically when fitness test analysis data is

saved in OmniSense Analysis
· It governs the maximum value of the sweep scale in the

subject BioGauge heart rate display
· It is used to calculate HR as a percentage of maximum heart

rate, when displayed in the subject BioGauge.
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7.21 Heart Rate Recovery (HRR)

Heart Rate Recovery Drop in heart rate following cessation of activity

OmniSense Live Subject details

OmniSense Analysis Readiness Report

Log Data N/A

Units Beats per minute over defined interval (30/60/120/180 sec)

Range 0 - 240

Reporting Frequency Per Event

Notes A fixed value saved in the OmniSense database. 
· when a new subject is added it can be entered manually
· It will be calculated automatically in OmniSense Analysis from

analysis of data from an Orthostatic Hypotension Test

Heart Rate recovery value can be used to give a measure of relative fitness. 

It is commonly defined as the drop in heart rate following cessation of activity over a 30
sec interval, but this index can also be used over 60, 120 and 180 second intervals.
OmniSense can provide all of these values automatically, if the subject maintains a low
activity level (e.g. sitting or lying down) for the entire 180 seconds after ceasing activity.

The activity level above which activity must pass, and below which it must remain, to
satisfy the criteria for the HRR algorithm to succeed, are configurable in the User
Preferences dialogue of the OmniSense Live module.

Heart Rate recovery values are calculated in the BioModule and transmitted at each data
request from the OmniSense Live application – they are saved to the OmniSense database
and made available in the Analysis module.

The criteria for HRR recovery calculation are:

Active State
· A high rate of activity - VMU > 0.8 (configurable – see OmniSense Live User Guide)
· High heart rate - HR > 85% HR max

Resting State
· Low rate of activity - VMU < 0.2 (must be maintained for 30 - 180 seconds)

· If the subject causes an activity spike greater than 0.2 during the recovery phase, then
the implication is that heart rate may increase momentarily, and render invalid the
amount it has reduced during recovery. The HRR value will not be updated if such a
spike is detected.

The following graphs are of a submaximal alternating run/rest test showing the various HRR
options, graphed against Heart Rate:
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 Note that the order in which a pair of parameters is selected determines which is the
easier to read on the graph. The moveable vertical cursor auto-positions to data points on
the first parameter selected.

7.22 Heart Rate Resting

Heart Rate Resting Subject's resting heart rate, saved in OmniSense database

OmniSense Live Subject details

OmniSense Analysis Readiness Report

Log Data N/A

Units Beats per minute

Range 0 - 240

Reporting Frequency N/A

Notes A fixed value saved in the OmniSense database. 
· when a new subject is added it can be entered manually
· It will be calculated automatically in OmniSense Analysis from

analysis of data from an Orthostatic Hypotension Test

7.23 Heart Rate Standing

Heart Rate Standing Subject's standing heart rate, saved in OmniSense database

OmniSense Live Subject details

OmniSense Analysis Readiness Report

Log Data N/A

Units Beats per minute

Range 0 - 240

Reporting Frequency N/A

Notes A fixed value saved in the OmniSense database. 
· when a new subject is added it can be entered manually
· It will be calculated automatically in OmniSense Analysis from

analysis of data from an Orthostatic Hypotension Test
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7.24 Heart Rate Variability

Heart Rate Variability A measure of the dynamic complexity of the ECG

OmniSense Live Subject details

OmniSense Analysis Reports

Log Data Summary & Enhanced formats

Units Milliseconds

Range

Reporting Frequency 1Hz after first 300 beats (~5 minutes)

Notes · A rolling 300 beat SDNN value (standard deviation of normal-
normal intervals)

· No data is available for ~ 5 minutes of BioModule power on

HRV is a measure of the small variations in R to R intervals

SDNN is the most representative parameter of HRV. Sometimes the term 'HRV' in medical
papers indicates 'SDNN' among many papers of HRV analysis. Thus low SDNN is low HRV,
which primarily indicates a reduction in dynamic complexity.

A healthy individual has a more irregular (higher) and complex HRV signal.

Age
(Decad

e)

Mean
SDNN

Notes

10s 55 > 50:  High normal, Autonomic Nervous System's regulating function and
stress coping ability good
35-50: Low-mid normal. The ANS's regulating function and stress coping
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ability good
20-35: Low. There's risk of developing stress induced disease. ANS
function is weakened.
< 20: Very low. There is a high risk of having chronic stress induced
disease related to ANS dysfunction

20s 47

30s 41

40s 37

50s 32 > 40: High normal
20-30: Low-mid normal
15-20: Low
< 15: Very low

60s 27

The clinical meaning of a decrease in SDNN is as follows:

· weakened autonomic nervous system's ability to keep homeostasis against the body's
internal (e.g. core temperature) or external environmental changes

· lowered coping ability to various emotional or physical stressors
· general weakness of health

Diseases associated with lowered HRV

· Myocardial infarction · Diabetic autonomic
neuropathy

· Guillan-Barre syndrome

· Angina pectoralis · Brain injury · Depression

· Ventricular arrhythmia · Epilepsy · Anxiety disorder (Panic
disorder)

· Sudden cardiac death · Multiple sclerosis · Autonomic dysrhythmias

· Coronary artery disease · Fibromyalgia · Stress induced diseases

· Congestive heart failure · Obesity

· Diabetes mellitus · Chronic Fatigue syndrome

7.25 Heart Rate Variability (Resting)

Heart Rate Variability
Resting

Resting HRV

OmniSense Live Subject Details

OmniSense Analysis Readiness Report

Log Data N/A

Units Milliseconds

Range

Reporting Frequency N/A

Notes · Saved from analysis of an Orthostatic Hypotension Test data
in OmniSense Analysis

7.26 Height

Height Subject Height

OmniSense Live  Subject details

OmniSense Analysis N/A

Log Data N/A
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Units Meters or inches

Range

Reporting Frequency N/A

Notes · Entered manually in subject details. Used in BMI (Body Mass
Index) calculations

7.27 Impact

Impact Peak Acceleration in previous reporting period

OmniSense Live Subject details

OmniSense Analysis Time & Summary graphs

Log Data All formats

Units g

Range 0 - 16

Reporting Frequency 1 - 5 sec, dependent on ECHO setting

Notes · Peak Acceleration Magnitude in the previous reporting epoch, 

using SQRT(x2 + y2 + z2) where x,y & z are the axial
acceleration values sampled at 100Hz

7.28 Impact Peak Magnitude Phi & Theta

Impact Peak Magnitude
Phi & Theta

Direction of angle of peak impact in the previous epoch

OmniSense Live Subject BioGauge

OmniSense Analysis Time & Summary graphs

Log Data Enhanced Formats

Units Degrees from vertical (phi), degrees from forward heading
(theta)(see diagrams below)

Range -180 - +180

Reporting Frequency 1 - 5 sec, dependent on ECHO setting

Notes · direction of impact angle is determined by analysis of the
three axial accelerometer streams



Parameters 97

© 2016 Zephyr Technology

7.29 Impulse Load

Impulse Load Accumulation of all impulses

OmniSense Live Subject BioGauge

OmniSense Analysis Time & Summary graphs

Log Data Enhanced Formats

Units Newtons

Range 0 - 

Reporting Frequency 1 Hz

Notes · the sum of the areas under the accelerometer magnitude
curve for all impulses

· reset when the BioModule is power cycled

7.30 Intensity and Load

In creating an exercise program it is important to ensure that mechanical load is gradually
increased through the season as athletes become conditioned.  

A high level repetitious mechanical load with unconditioned athletes can lead to stress
fractures, shin splints, joint pain, or other "over use" injuries in short time.  However, it is
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important to get enough mechanical load in your training plan to ensure good
musculoskeletal development.  The key is in the adaptation.  

These parameters are provided to enable the coach to more effectively monitor these
early warning signs and create adaptive training plans that optimize performance.

The balance of mechanical to physiological indicators measured for multiple individuals
performing the same activity can give an indication of efficiency and even "heart".  

A high mechanical combined with a low physiological score relative to the others would
indicate an individual is more efficient.  Conversely, a high physiological and comparable
mechanical output relative to others would indicate that an individual may be less efficient
but have more mental stamina to compensate.  

These concepts should only be considered under controlled activity circumstances and
when individual subject profiles have all been calibrated using the baseline ramped effort
fitness testing method.

Physiological Intensity & Load - a measure of a subject's cardiovascular workout 

Mechanical Intensity & Load - a measure of a subject's musculoskeletal workout 

Training Intensity & Load - the arithmetic average of the above 

Physiological intensity measures a person’s cardiovascular output.  A score of 0 is a
resting level whereas a score of 10 is equivalent to the individual working at their maximal
effort.  This scale is based on the individual's customizable HRmax which can be measured
and stored in their profile by performing a ramped effort baseline test (treadmill or beep
test protocols outlined in OmniSense Analysis User Guide).

Physiological load provides a measure of the overall physiological output of a workout.  By
taking this value into account a coach can characterize workout’s difficulty (based on
cardiovascular demand) on an individual or team basis.

Mechanical intensity is the measure of a person’s kinematic output.  A mechanical
intensity of 0 means that the subject is not putting any impact onto their musculoskeletal
system whereas a score of 10 is equivalent to a sprinting level of impact and movement.  

In creating an exercise program it is important to ensure that mechanical load is gradually
increased through the season as athletes get conditioned.  A high level repetitious
mechanical load with unconditioned athletes can lead to stress fractures, shin splints,
joint pain, or other "over use" injuries in short time.  However, it is important to get
enough mechanical load in your training plan to ensure good musculoskeletal development.
 The key is in the adaptation of the program through a well-devised periodization scheme
that balances both mechanical and physiological demands and requirements.  These
parameters are provided to enable the coach to more effectively monitor these early
warning signs and create adaptive training plans that optimize performance.  

The balance of mechanical to physiological indicators measured for multiple individuals
performing the same activity can give an indication of efficiency and even "heart".  A high
mechanical score combined with a low physiological score relative to the others would
indicate an individual is more efficient.  Conversely, a high physiological and comparable
mechanical output relative to others would indicate that an individual may be less efficient
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but have more mental stamina to compensate, they have “heart”.  These concepts should
only be considered under controlled activity circumstances and when individual subject
profiles have all been calibrated using the baseline ramped effort fitness testing method.  

Also, by looking into the balance of mechanical and physiological load and intensity values
for a player or team, day to day throughout the season, a coach can glean out of the
“Periodization Report” which days the players are working more and less efficiently (when
they are performing prescribed amounts of work), or even on what days a player or team
are working most efficiently.  By identifying the patterns associated with the workouts and
games over a season, a coach can better optimize the periodization scheme of the team
to make sure the players are performing at their best when it really matters.  And
conversely, when they are working hard enough (“putting money in the bank”) to ensure
that they are at their optimal conditioning level with impacting their performance in the
key competitions.

These are the logic tables for how we calculate load and intensity in our software.
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Bluetooth PSM systems report data at 1 second intervals. ECHO systems
report at 2.5 second intervals. For this reason, load and intensity values should
only be compared between sessions gathered on the same system, and of the

same type e.g. both log sessions, or both transmitted sessions. Peak
Acceleration values are always used in the calculations, and there is a greater
likelihood that larger peak acceleration values will be found in the longer 2.5
second intervals. Valid comparisons can't be made between data sessions

acquired on differing sessions.
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7.31 Jump

Jump Peak g during a jump event

OmniSense Live Subject BioGauge

OmniSense Analysis Time & Summary graphs

Log Data N/A

Units g

Range 0 - 16

Reporting Frequency Per event

Notes · the peak (upward) g detected during a jump event
· jump criteria must be satisfied (crouch, pause, upward

acceleration and time in the air)

7.32 Jump Count

Jump Count Count of detected jump events

OmniSense Live Subject BioGauge

OmniSense Analysis Time & Summary graphs

Log Data Enhanced Formats

Units Count

Range 0 - 

Reporting Frequency 1 Hz

Notes · distinguished from a bound or a step by the time in the air
· available from OmniSense 4.0 and later
· reset when the BioModule is power cycled

7.33 Location

Location Geographic location (supported GPS required)

OmniSense Live Map side panel, Map window

OmniSense Analysis Map Panel/Window

Log Data Summary and Enhanced formats

Units Latitude & Longitude

Range

Reporting Frequency 1 Hz

Notes · a supported GPS is required

7.34 Major Impact Count

Major Impact Count Count of Major Impacts

OmniSense Live Subject BioGauge

OmniSense Analysis Time and Summary Graphs, Impact reports

Log Data Enhanced formats

Units Cumulative Count

Range 0 - 

Reporting Frequency 1 Hz
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Notes · Major impact has peak accelerometer magnitude during the
event greater than 7g

· detected angle of impact distinguishes impact from a step

7.35 Mechanical Intensity

Mechanical Intensity Index of kinetic output

OmniSense Live Subject BioGauge

OmniSense Analysis Time and Summary Graphs

Log Data N/A

Units None

Range 0 - 10

Reporting Frequency 1 Hz

Notes · Calculated within OmniSense
· Peak Accelerometer Magnitude during epoch determines level

of Intensity on 0 - 10 scale
· Upper and lower peak g limits for the range are configurable in

Live Preferences
· An Intensity level of 10 is equivalent to a sprinting level of

impact and movement
· A subject whose peak acceleration values are less than 0.5g

is considered to be resting. Mechanical Intensity = null. A null
value will not bias any average intensity calculation if resting
periods are included in a session. Walking will soon increase it
above the 0.5g level.

· Average mechanical intensity (per minute) = Mechanical load/
session duration in minutes

Mechanical Intensity is defined according to the range into which the Peak (in any axis)
acceleration g value fits in any one second epoch, again stated as 1/60th minute. A value
is assigned according to:

Intensity
Level

Description

Null (no
value)

Peak acceleration magnitude less than 0.5g (subject effectively resting)

1...9 Value scaled linearly between 0.5 (= 0) and 3.0g (= 10) e.g. 1.25g =
Intensity of 5

10 Peak acceleration magnitude of 3.0g or greater

Thus a jogger who is running at a constant rate which generates (say) a peak g value of
2.0 for each epoch will have a constant Mechanical Intensity of 6
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Mechanical Intensity plotted against peak acceleration during a treadmill test:

· Intensity increases as peak acceleration increases

Note: during activity sessions which involve much stop-start activity, Mechanical
Intensity data may look chaotic, such as during soccer practice:
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 It will be necessary to use the graph zoom function to see data at a usable resolution:
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7.36 Mechanical Load

Mechanical Load Cumulative index of kinetic output, based on Mechanical
Intensity

OmniSense Live Subject BioGauge

OmniSense Analysis Time and Summary Graphs

Log Data N/A

Units None

Range 0 - 10

Reporting Frequency 1 Hz

Notes · Mechanical Intensity values are accumulated
· Mechanical load is a measure of total kinematic output and will

give a good indication of an individual's overall level of effort
compared to their historic data, or to a group, for a given
training session.

The blue line represents mechanical load. It increases only when mechanical intensity > 0
(peak g > 0.5g or configured value)

Mechanical load is the accumulation of the Mechanical Intensity value over time.

The same jogger’s Mechanical Load will increase by 6 each second, so their total
Mechanical Load after 3 minutes will be
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AVERAGE MECHANICAL INTENSITY (per minute)
For the above example:

= 6

Example
Mechanical Load plotted against peak acceleration during a treadmill test:

· Load increases more gradually during warm up
· Load curve steepens during test as peak acceleration increases
· Load curve flattens when peak acceleration reduces

7.37 Minor Impact Count

Major Impact Count Count of Minor Impacts

OmniSense Live Subject BioGauge

OmniSense Analysis Time and Summary Graphs, Impact reports

Log Data Enhanced formats

Units Cumulative Count

Range 0 - 

Reporting Frequency 1 Hz
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Notes · Minor impact has peak accelerometer magnitude during the
event between 3g and 7g

· detected angle of impact distinguishes impact from a step

7.38 Physiological Intensity

Mechanical Intensity Index of cardiac output

OmniSense Live Subject BioGauge

OmniSense Analysis Time and Summary Graphs

Log Data N/A

Units None

Range 0 - 10

Reporting Frequency 1 Hz

Notes · Calculated within OmniSense
· Heart rate as a % of subject's stored HRmax determines

Intensity on a 0 - 10 scale
· Upper and lower %HR

max
  limits for the range are configurable

in Live Preferences
· An Intensity level of 10 is equivalent to 100% HR

max
 

· A subject whose %HR
max

 value is less than 50% is considered

to be resting. Physiological Intensity = null. A null value will
not bias any average intensity calculation if resting periods
are included in a session. Walking will soon increase it above
the 50% level.

· Maximum Heart Rate can be measured using a ramped
maximal fitness test

· Average physiological intensity (per minute) = Physiological
load/session duration in minutes

Intensity
Level

Description

Null (no
value)

Less than 50% of subject's maximum heart rate. 

... Value scaled linearly between 50% (= 0) and 100% (= 10) e.g. 75% HR
max

= Intensity of 5

10 100% of maximum heart rate or greater
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Physiological Intensity (thick line) plotted against heart rate during a treadmill test:

· the maximum intensity level 10 is reached at maximum heart rate

AVERAGE PHYSIOLOGICAL INTENSITY (per minute)
For the above example:



Parameters 109

© 2016 Zephyr Technology

= 6

7.39 Physiological Load

Mechanical Load Cumulative index of cardiac output, based on Physiological
Intensity

OmniSense Live Subject BioGauge

OmniSense Analysis Time and Summary Graphs

Log Data N/A

Units None

Range 0 - 10

Reporting Frequency 1 Hz

Notes · Physiological Intensity values are accumulated
· Physiological load is a measure of total cardiovascular output

and will give a good indication of an individual's overall level of
effort compared to their historic data, or to a group, for a
given training session.

The blue line represents physiological load. It increases only when physiological intensity >
0 (HR > 50%HR

max
 or configured value)

Physiological load is the accumulation of the Physiological Intensity over time.

The same jogger’s Physiological Load will increase by 6 each second, so their total
Physiological Load after 2 minutes will be
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Physiological Load plotted against heart rate during a treadmill test:

· Load increases more gradually during warm up
· Load curve steepens during test as heart rate increases
· Load curve increases less gradually when heart rate reduces

Load data is typically most useful viewed in Summary form:
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This graph shows that less physiological load has been accumulated by Subject 3, in blue.

7.40 Posture

Posture Orientation of subject

OmniSense Live Subject BioGauge

OmniSense Analysis Time and Summary Graphs

Log Data All formats

Units Degrees from vertical

Range -180 - +180

Reporting Frequency 1 Hz

Notes · Subject vertical (sitting or standing) = 0 degrees
· Subject inverted = ±180 degrees
· Lateral (side to side) changes in posture are not detected -

only lean forward/lean back. If posture indication is wrong,
confirm that the garment type in subject setup is set
correctly.
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7.41 ROG Subject Status

ROG Subject Status Color indication of subject physiological status in BioGauge

OmniSense Live Subject Status

OmniSense Analysis Time Graph

Log Data Summary & Enhanced formats

Units Red/Orange/Green

Range N/A

Reporting Frequency 1 Hz

Notes · The ROG algorithm combines activity level, Heart Rate,
Breathing Rate and Estimated Core Temperature, and raises
subject status to Orange and then to Red if thresholds, such
as those indicated below are crossed. The time in a particular
state is also taken into account.

Red-Orange-Green subject status is recorded in the database and can be displayed in two
ways.

Line Graph
· select from Time Variables pane
· ROG status, heart rate & breathing rate are displayed. No other parameters can be

selected.
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· N/W in the cursor values field for ROG indicates 'Not Worn'
· N/C in the cursor values field for ROG indicates 'Not Connected'

Background Color
· Allows ROG status to be superimposed on any two other physiological parameters
· Select ROG using the check box above the raw data graphs
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Green = values inside expected limits for activity level
Orange = values have crossed inner threshold, subject should be monitored accordingly
Red = values have crossed outer thresholds, subject should be monitored more closely
Grey = low heart rate confidence, or device not worn
Blue = communications error
 Thresholds can be configured in the OmniSense Live > Preferences > Safety Thresholds
dialogue
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·  If either HR or BR move into the zones shown, the status will change accordingly.
 

7.42 Run Step Count

Run Step Count Count of detected run steps

OmniSense Live Subject BioGauge

OmniSense Analysis Time & Summary graphs

Log Data Enhanced Formats

Units Count

Range 0 - 

Reporting Frequency 1 Hz

Notes · distinguished from a bound or a walking step by activity level
· available from OmniSense 4.0 and later
· reset when the BioModule is power cycled

7.43 Saturated Blood Oxygen Level

Saturated Blood Oxygen
Level

Percentage saturated blood oxygen (external sensor needed)

OmniSense Live Sensors side panel, details panel

OmniSense Analysis Time & Summary graphs

Log Data None

Units %

Range 90 - 100

Reporting Frequency Set in Live Preferences - default 60 seconds

Notes · Supported by Bluetooth Radio Network type only
· SpO

2
 sensor must be added to system

· The PC sends a request to the BioModule, which requests
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data from the SpO
2
 sensor. The BioModule receives the data

and sends it back to the PC. No data is logged in the
BioModule.

7.44 Signal Strength

Signal Strength Received signal strength from BioModule

OmniSense Live Subject BioGauge (bar indication)

OmniSense Analysis Time graphs

Log Data Summary & Enhanced formats (Bluetooth RSSI)

Units Bar indication on BioGauge

Range 1-5

Reporting Frequency 1 Hz

Notes

7.45 Speed

Distance Traveled GPS speed

OmniSense Live Subject BioGauge

OmniSense Analysis Time and Summary graphs, Reports

Log Data Waveform or Development formats only

Units Miles per hour or Kilometers per hour, configured in Preferences

Range 0 - 

Reporting Frequency 1 Hz

Notes · Data gathered by a supported GPS device, and relayed to
BioModule

· BioModule must be configured to log in Summary and
Waveform or Enhanced Summary and Waveform  using Zephyr
Config Tool

7.46 Time in Heart Rate Zones

Time in Heart Rate Zones Minutes spent in each Training Zone for a session

OmniSense Live N/A

OmniSense Analysis Summary Graphs

Log Data N/A

Units Minutes

Range 0 - 

Reporting Frequency N/A

Notes · Available as a Summary variable. Displays as shown below
· Training Zones are configurable in Preferences

Selection of this summary variable displays the graph below. This graph gives a very
effective summary of relative performance for a number of subjects involved in the same
activity.
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7.47 Training Intensity

Training Intensity Index of total (cardiac + mechanical) output

OmniSense Live Subject BioGauge

OmniSense Analysis Time and Summary Graphs

Log Data N/A

Units None

Range 0 - 10

Reporting Frequency 1 Hz

Notes · The arithmetic average of Mechanical Intensity and
Physiological Intensity

The relationship is shown by this export of the 3 intensity metrics for one of the soccer
practice sessions from 2012 :
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Note that any blue Mechanical Intensity peaks of greater than 3.0g register as the
maximum 10 on the Intensity scale - hence the apparent 'clipping'. The maximum
Physiological Intensity is 100% HR max. If this is exceeded then HR

max
 should be adjusted

accordingly for that subject. 

7.48 Training Load

Training Load

OmniSense Live Subject BioGauge

OmniSense Analysis Time and Summary Graphs

Log Data N/A

Units None

Range 0 - 10

Reporting Frequency 1 Hz

Notes · Arithmetic average of Mechanical Load & Physiological Load

Likewise, Training Load is the average of physiological and mechanical loads. For the same
session as above:
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Care should be taken when interpreting Training Intensity & Load, if the
activity involved involves much physiological effort but no mechanical effort
which would be detected by the BioHarness, such as weight lifting, or erg
workouts. Training Intensity and Load may not reflect the true level of
workout involved, since mechanical intensity will be determined as low

7.49 Walk Step Count

Walk Step Count Count of detected walking steps

OmniSense Live Subject BioGauge

OmniSense Analysis Time & Summary graphs

Log Data Enhanced Formats

Units Count

Range 0 - 

Reporting Frequency 1 Hz

Notes · distinguished from a bound or a jump by activity level, time in
the air

· available from OmniSense 4.0 and later
· reset when the BioModule is power cycled

7.50 Weight

Weight Subject Weight

OmniSense Live Subject BioGauge

OmniSense Analysis N/A
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Log Data N/A

Units Kilograms or pounds

Range

Reporting Frequency N/A

Notes · Entered manually in Subject Details in OmniSense Live. Used in
BMI calculations
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8 Data Export & Import

Data can be exported in two ways:

Displayed data as an external csv File 
can be viewed in Excel or similar

cannot be imported into OmniSense

Individual Session as a .zsf file 
can only be viewed using OmniSense

can be imported into another instance of
OmniSense

 

8.1 Export Graph Data to External Files

In the graph pane there is an  button which will export the contents of the graph
(but no other data) one of several formats:
·  .csv file, which opens by default in Excel®
· .JPEG, .GIF, .PNG, .Tiff or  .SVG image files
· .PDF document file



Data Export & Import 123

© 2016 Zephyr Technology

CSV Files
Export and save to a suitable location.

When opened in Microsoft® Excel, the timestamp data will be in Excel Serial Date Format.
It must be converted for readable results.
 

8.1.1 Change Excel Date Format

1. The default Excel date format, as seen in exported csv files, is an Excel Serial Date
Format
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2. To change the date format to show full milliseconds, or any other date or time
information:
   

   Highlight the entire timestamp column, right-click, and select Format Cells from the
context menu
3. Select Custom from the Category List, and enter dd/mm/yyyy hh:mm:ss.000 (or any
combination of these special characters, and any other delimiting characters or symbols)
in the Type field:
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4. The timestamp column will be converted to the required format
   

 

   Note that to preserve this formatting, the csv file must be saved as an .xlsx worksheet,
and not as a .csv file.

8.2 External zsf File

Individual sessions in the Select Session tree can be exported to an external .zsf (Zephyr
Serial File) file. This allows their transfer between separate instances of OmniSense. The
.zsf file can then be re-imported into another Analysis module.

1. Select a session (or sessions, using the Ctrl key while selecting) and right-click,
selecting Export
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2. Browse and find a suitable location to save

8.3 External KML File

Individual sessions in the Select Session tree can be exported to an external .kml (Keyhole
Markup Language) file for import into Google Earth or Google Maps. This option only
becomes active when the selected session contains actual GPS data.

1. Select a session (or sessions, using the Ctrl key while selecting) and right-click,
selecting Export
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2.Browse and find a suitable location to save

3. If Google™ Earth has been installed (Download from http://www.google.com/earth/
download/ge/agree.html) then open the file at its saved location:

4. The file will open Google Earth automatically if an internet connection is present, and
scale to the map track, with a scrollbar to move the location pin around the track.

   

http://www.google.com/earth/download/ge/agree.html
http://www.google.com/earth/download/ge/agree.html
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4. To display physiological data, right-click on the file in the Places navigation tree in
Google Earth, and select Show Elevation Profile from the context menu as shown. A
histogram will display. Above the histogram are a series of links which will allow display of:
· Elevation
· Speed
· Heart Rate
· Altitude
· Estimated Core Temperature
· Activity Level
· Peak Acceleration
The selected values will be displayed beside a location beacon which moves around the
GPS track as your PC cursor is floated over the histogram.

8.4 Importing an External zsf File

1.Click the Import  button and select From File from the drop-down menu

 
2.Select the .zsf file to import
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3.A dialogue will display showing all sessions in the serialized file. If any session already
exists in the target database (with the same name), then the checkbox on the right will
be ticked, and import prevented.



Part 9
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9 Log Data

A BioHarness Bluetooth (v2.0 or v3.0) is normally configured to log all data as well as
transmit. [An ISM BioHarness can be set to Log mode using the button on the device. See
your PSM system user manual for instructions.]

The Zephyr Downloader Utility has been optimized to download logs from up to 50
BioModules installed in a PSM Training System Case:

The Downloader utility will also work using Zephyr 5-device or single device charging/USB
cradles. The utility will download from 6 devices over USB, and 6 devices over Bluetooth,
simultaneously. Other detected BioModules will be queued and downloaded automatically. 

Logs downloaded over Bluetooth will take longer than those downloaded over USB. Devices
whose logs are downloaded over Bluetooth need not be connected to the host PC, but
powered on and within Bluetooth range (typically 10 yards).

The Downloader will not download the same log from the same device twice.

Processing of logs will take longer if the user chooses to generate external csv files from
the Downloader menu Options

Typical Download times (will vary according to PC specification and resource available):

L
o
g
g
i
n
g
F

Session
Length

Download Path
Download Time 

(1 device)
Download Time 

(5 devices)
Download Time
(10 devices)
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t
)

1 hour USB 25 sec 1 min 15 sec 2 min

S
u
m
m
a
r
y
a
n
d
W
a
v
e
f
o
r
m
*

1 hour USB 1 min 45 sec 3 min 45 sec 6 min

S
u
m
m
a
r
y
a
n
d
D
e

1 hour USB 4 min 6 min 30 sec 11 min
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v
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*
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*
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*
*

1 hour USB 30 seconds 2 min 3 min 45 sec

E
n
h
a
n
c
e
d
S
u
m
m
a
r
y
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d
W
a
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e
f

1 hour USB
2 min 6 min 7 min
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n
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y
a
n
d
D
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e
l
o
p
m
e
n
t
*
*
*

1 hour USB 4 min 7 min 13 min

* Summary/Enhanced Summary and Waveform format is necessary to log speed and
location data from a supported GPS unit, or for accelerometer data required for detailed
impact analysis by the Impact Analysis Tool
** Enhanced Summary format is required for display of impact analysis parameters (impact
type, magnitude, count, etc) which are calculated directly in the BioModule
*** Development log formats record ECG at 1KHz, and accelerometry data is reduced from
100Hz to 50 Hz to accomodate
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9.1 Zephyr Downloader

The Zephyr Downloader is accessed from the Toolbar - select the From BH option:

The Zephyr Downloader dialogue will display:

Menu

File

· Exit only

View

· Unchecked - basic view (see below)

· Checked - Wizard view (as above)

Options

· Retry on Error - will continually retry to download logs. Abort manually

· Synchronize Device Clocks - legacy option - all device clocks are
synchronized to PC time over ECHO when Live is started. Leave checked
as security.

· Auto Download Configured Units - log download will start automatically,
with data going to the Team/Subject combination as currently deplyoyed in
the database. Unchecked by default.

· Auto Erase After Download - erase logs on download. Logs are
automatically overwritten (oldest first) when device memory is full.

· Auto Discover Bluetooth Device - detect BioModule over Bluetooth, but
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do not download
· Write CSV Format Log Files - write external .csv files to ...\My

Documents\BioHarness Test Logs\...a folder is created with time and date
stamp as part of file name

· Write DaDisp Format Log Files - write external .hed/.dat files to the
same location as csv for import into DaDISP application

· Write GPS data to KML File - write kml files containing location & basic
vital signs for display in Google Earth

Wizard

1. Select Team - a BioModule may be assigned to two subjects in
different Teams, not deployed at the same time. Select the appropriate
Team.

2. Retrieve Team/Subject Combo - auto-populate Team/Subject
Combinations

3. Select Session Range - defaults to the previous 24 hours. No sessions
will display if older than this - reset manually to display

4. Session Name - change to a name which will make filtering easier in
the Filter Session list [Show Sessions]

5. Download Team Sessions - start download manually

Columns

Device Name Button - as named in the OmniSense database - this should
be labeled on the front for identification. If 'Unknown' then the device has
not been added to the system via OmniSense Live > Setup > Hardware. If
pressed it will display the legacy Log Downloader Tool which can be used
to view all Logs in the device, and download to external files if necessary.

Device SN - serial number as detected by the system (USB or BT): 
BHT######

Team - use the pulldown to edit manually if needed

Subject - use the pulldown to edit manually if needed

Status - various status messages displayed

Button - action button (dependent on status)

Button - action button (display messages)

Zephyr Downloader Basic View - Team & subject must be selected manually, and Start
Download button used for each device individually.
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9.2 AutoDownload Workflow

The Zephyr Downloader has been designed to allow download of logs from 50 devices in
the PSM system case (or multiple device cradles) with minimal user input, if the system is
configured correctly.

Pre-requisites:
· All BioModules must already be added into the system, via OmniSense Live > Setup >

Hardware
· All BioModules must be assigned to members of the same team, and that team currently

deployed in OmniSense Live
· Logs should be downloaded on the day they are recorded, otherwise the Select Session

range values must be changed.
· Logs should not have been previously downloaded - otherwise 'No New Logs' will display

for that device
· All BioModules must be in the PSM Training system case, or located in USB charging

cradles which power them on

Workflow for Autodownload of same-day logs
Wizard

1
Select Team (BioModules may be assigned to more than one
team in the database)

4

Change the default 'log' session name to something more
meaningful, which can be used when filtering sessions in the
Filter Session panel to display logs as graphs or for creating
reports.

 
Select Auto Download from the options menu. Once this is
checked, you can leave the Download Tool open, and add and
remove BioModules as they become available.

Optional Manual adjustments

2

Use Update button to populate the Team & Subject
button/fields in the dialogue. This is as they are stored
in the database. If a device has been reassigned to
another subject, change manually using the subject
pulldown, otherwise data will go to the 'wrong' subject.

3

Set the start and end time & date to cover the logs to
be downloaded. The default settings are the previous
24 hours and no logs will show if they pre-date this
interval.

5 Manually initiate log download.

9.3 Log Downloader Legacy Tool

This can be accessed from the Zephyr Downloader (use the device name button), or at C:
\Program Files (x86)\Zephyr\OmniSense\Tools there is a legacy tool BioHarness Log
Downloader.exe. This can be used to check which logs are present on a device, regardless
of how they are timestamped. If a BioHarness undergoes a complete reset and the clock is
not resynchronized to current PC time by either:



 138

© 2016 Zephyr Technology

· connecting to a PC and attempting to download logs into the Analysis modules using the
toolbar button

· using the Zephyr Cfg Tool which is described in the Live Help file

..then files may be timestamped from Jan 1st 2000.

The Log Downloader will display all logs on the selected device. It will save logs as
external csv and/or dat/hed files, located in My Documents\BioHarness Test Logs as
default, or uncheck the Use Default Save Location box to save elsewhere.

9.4 Logging Formats

BioModules are configured to log data by default. Logging can be turned on or off and the
logging format set, by using the Zephyr Config Tool.

There are a number of logging formats. Use the links below to see the parameters
contained in each format.

Format Description

General Legacy format originated for BioModule 1.0
and 2.0. Still supported in 3.0

General and ECG 250Hz ECG waveform logged in addition to all
General log parameters

General and Accelerometer 100Hz Accelerometer magnitude data logged
in addition to general log parameters
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Summary General + Additional 1 Hz parameters

Summary and Waveform Summary + 250Hz ECG, 100 Hz
Accelerometer, 25 Hz Breathing waveforms.
Separate RR and BB external files

Summary and Development ECG increased to 1000Hz, Accelerometry
reduced to 50Hz

Enhanced Summary Additional Impact parameters, from
OmniSense 4.0 onwards

Enhanced Summary and Waveform As above for Summary

Enhanced Summary and Development As above For Summary

· When log data is imported into OmniSense analysis, not all parameters are added to the
OmniSense database for view in the Analysis graphs.

· In addition, data can be saved as external csv files by the Zephyr Downloader in
OmniSense Analysis. 

· Some data (principally waveforms)can only be saved as external .csv files and viewed
using external 3rd party applications.

The total logging capacity of a BioModule varies according to the log format:

Format Total Logging Capacity
(Hours)

Approximate Download Time
per hour of data (Single

BioModule)

General 500

General and ECG 140

General and Accelerometer 280

Summary 450 10 sec

Summary and Waveform 60 30 sec

Summary and Development 30 1 min 30 sec

Enhanced Summary 450 12 sec

Enhanced Summary and
Waveform

60 45 sec

Enhanced Summary and
Development

30 2 min

9.4.1 General

Format Reporting
Frequency

Parameter External csv Filename Imported
Into
OmniSen
se

General 1 Hz Heart Rate
Breathing Rate
Skin Temperature
Posture
Activity
Acceleration
Battery
BR Amplitude
ECG Amplitude

yyyy_mm_dd-hh_mm_ss_General Yes
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ECG Noise
X Acc Min
X Acc Peak
Y Acc Min
Y Acc Peak
Z Acc Min
Z Acc Peak

18 Hz Breathing Waveform
Heart R-R

yyyy_mm_dd-hh_mm_ss_BR_RR No

Per Event Event Code
Event Type
Source
Event ID
Event Specific Data

yyyy_mm_dd-
hh_mm_ss_Event_Data

No

9.4.2 General and ECG

Format Reporting
Frequency

Parameter External csv Filename Imported
Into
OmniSen
se

General
and ECG

1 Hz Heart Rate
Breathing Rate
Skin Temperature
Posture
Activity
Acceleration
Battery
BR Amplitude
ECG Amplitude
ECG Noise
X Acc Min
X Acc Peak
Y Acc Min
Y Acc Peak
Z Acc Min
Z Acc Peak

yyyy_mm_dd-hh_mm_ss_General Yes

18 Hz Breathing Waveform
Heart R-R

yyyy_mm_dd-hh_mm_ss_BR_RR No

Per Event Event Code
Event Type
Source
Event ID
Event Specific Data

yyyy_mm_dd-
hh_mm_ss_Event_Data

No

250 Hz ECG waveform yyyy_mm_dd-hh_mm_ss_ECG No

9.4.3 General and Accelerometer

Format Reporting
Frequency

Parameter External csv Filename Imported
Into
OmniSen
se



Log Data 141

© 2016 Zephyr Technology

General
and
Accelero
meter

1 Hz Heart Rate
Breathing Rate
Skin Temperature
Posture
Activity
Acceleration
Battery
BR Amplitude
ECG Amplitude
ECG Noise
X Acc Min
X Acc Peak
Y Acc Min
Y Acc Peak
Z Acc Min
Z Acc Peak

yyyy_mm_dd-hh_mm_ss_General Yes

18 Hz Breathing Waveform
Heart R-R

yyyy_mm_dd-hh_mm_ss_BR_RR No

Per Event Event Code
Event Type
Source
Event ID
Event Specific Data

yyyy_mm_dd-
hh_mm_ss_Event_Data

No

100 Hz Acc Magnitude yyyy_mm_dd-
hh_mm_ss_Accelmag

No

9.4.4 Summary

Format Reporting
Frequenc

y

Parameter External csv Filename Imported Into
OmniSense

Summary 1 Hz Heart Rate
Breathing Rate
Skin Temperature
Posture
Activity
Peak Acceleration
Battery Voltage
Battery %
BR Amplitude
BR Noise
BR Confidence
ECG Amplitude
ECG Noise
HR Confidence
HRV
System
Confidence
GSR Status
ROG Time
ROG
Vert Acc Min
Vert Ac peak

yyyy_mm_dd-
hh_mm_ss_Summary

Yes
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Lateral Acc Min
Lateral Acc Peak
Sagittal Acc Min
Sagittal Acc Peak
Device
Temperature
Status Info
Link Quality
RSSI
Tx Power
Core Temperature
Aux ADC1/2/3

Per Event Heart R-R yyyy_mm_dd-hh_mm_ss_RR No

Per Event Breathing B-B yyyy_mm_dd-hh_mm_ss_BB No

Per
Download

Subject
Information
Device Information
Session
Information

yyyy_mm_dd-
hh_mm_ss_SessionInfo.txt

No

Per event Event Code
Event Type
Source
Event ID
Event Specific
Data

yyyy_mm_dd-
hh_mm_ss_Event_Data

No

9.4.5 Summary and Waveform

Format Reporting
Frequenc

y

Parameter External csv Filename Imported Into
OmniSense

Summary and
Waveform

1 Hz Heart Rate
Breathing Rate
Skin Temperature
Posture
Activity
Peak Acceleration
Battery Voltage
Battery %
BR Amplitude
BR Noise
BR Confidence
ECG Amplitude
ECG Noise
HR Confidence
HRV
System
Confidence
GSR Status
ROG Time
ROG
Vert Acc Min

yyyy_mm_dd-
hh_mm_ss_Summary

Yes
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Vert Ac peak
Lateral Acc Min
Lateral Acc Peak
Sagittal Acc Min
Sagittal Acc Peak
Device
Temperature
Status Info
Link Quality
RSSI
Tx Power
Core Temperature
Aux ADC1/2/3

Per Event Heart R-R yyyy_mm_dd-hh_mm_ss_RR No

Per Event Breathing B-B yyyy_mm_dd-hh_mm_ss_BB No

Per
Download

Subject
Information
Device Information
Session
Information

yyyy_mm_dd-
hh_mm_ss_SessionInfo.txt

No

Per event Event Code
Event Type
Source
Event ID
Event Specific
Data

yyyy_mm_dd-
hh_mm_ss_Event_Data

No

100 Hz Vertical Accn
Lateral Accn
Sagittal Accn

yyyy_mm_dd-
hh_mm_ss_Accel

No

25 Hz Breathing
Waveform

yyyy_mm_dd-
hh_mm_ss_Breathing

No

250 Hz ECG Waveform yyyy_mm_dd-hh_mm_ss_ECGNo

1 Hz Location (Lat/
Long)
Altitude
GPS fix Quality
Speed Over
Ground
Track Angle
HDOP

yyyy_mm_dd-hh_mm_ss_GPS

* Supported GPS
devicerequired

Yes
(displayed on
Google Maps
in OmniSense
4.0)

9.4.6 Summary and Development

Format Reporting
Frequenc

y

Parameter External csv Filename Imported Into
OmniSense

Summary and
Development

1 Hz Heart Rate
Breathing Rate
Skin Temperature
Posture
Activity
Peak Acceleration

yyyy_mm_dd-
hh_mm_ss_Summary

Yes
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Battery Voltage
Battery %
BR Amplitude
BR Noise
BR Confidence
ECG Amplitude
ECG Noise
HR Confidence
HRV
System
Confidence
GSR Status
ROG Time
ROG
Vert Acc Min
Vert Ac peak
Lateral Acc Min
Lateral Acc Peak
Sagittal Acc Min
Sagittal Acc Peak
Device
Temperature
Status Info
Link Quality
RSSI
Tx Power
Core Temperature
Aux ADC1/2/3

Per Event Heart R-R yyyy_mm_dd-hh_mm_ss_RR No

Per Event Breathing B-B yyyy_mm_dd-hh_mm_ss_BB No

Per
Download

Subject
Information
Device Information
Session
Information

yyyy_mm_dd-
hh_mm_ss_SessionInfo.txt

No

Per event Event Code
Event Type
Source
Event ID
Event Specific
Data

yyyy_mm_dd-
hh_mm_ss_Event_Data

No

50 Hz Vertical Accn
Lateral Accn
Sagittal Accn

yyyy_mm_dd-
hh_mm_ss_Accel

No

25 Hz Breathing
Waveform

yyyy_mm_dd-
hh_mm_ss_Breathing

No

1000 Hz ECG Waveform yyyy_mm_dd-hh_mm_ss_ECGNo

9.4.7 Enhanced Summary

Format Reporting
Frequenc

Parameter External csv Filename Imported Into
OmniSense
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y

Summary 1 Hz Heart Rate
Breathing Rate
Posture
Activity
Peak Acceleration
Battery %
BR Amplitude
BR Noise
ECG Amplitude
ECG Noise
HR Confidence
HRV
ROG
Device
Temperature
Status Info
Link Quality
RSSI
Tx Power
Core Temperature
Aux ADC1/2/3
Impulse Load
Walk Steps
Run Steps
Bounds
Jumps
Minor Impacts
Major Impacts
Average Rate
Force
Development
Average Step
Impulse
Average Step
Period
Jump Flight Time
Peak g Phi Angle
Peak g Theta
Angle

yyyy_mm_dd-
hh_mm_ss_SummaryEnhance
d

Yes

Per Event Heart R-R yyyy_mm_dd-hh_mm_ss_RR No

Per Event Breathing B-B yyyy_mm_dd-hh_mm_ss_BB No

Per
Download

Subject
Information
Device Information
Session
Information

yyyy_mm_dd-
hh_mm_ss_SessionInfo.txt

No

Per event Event Code
Event Type
Source
Event ID
Event Specific

yyyy_mm_dd-
hh_mm_ss_Event_Data

No
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Data

9.4.8 Enhanced Summary and Waveform

Format Reporting
Frequenc

y

Parameter External csv Filename Imported Into
OmniSense

Summary 1 Hz Heart Rate
Breathing Rate
Posture
Activity
Peak Acceleration
Battery %
BR Amplitude
BR Noise
ECG Amplitude
ECG Noise
HR Confidence
HRV
ROG
Device
Temperature
Status Info
Link Quality
RSSI
Tx Power
Core Temperature
Aux ADC1/2/3
Impulse Load
Walk Steps
Run Steps
Bounds
Jumps
Minor Impacts
Major Impacts
Average Rate
Force
Development
Average Step
Impulse
Average Step
Period
Jump Flight Time
Peak g Phi Angle
Peak g Theta
Angle

yyyy_mm_dd-
hh_mm_ss_SummaryEnhance
d

Yes

Per Event Heart R-R yyyy_mm_dd-hh_mm_ss_RR No

Per Event Breathing B-B yyyy_mm_dd-hh_mm_ss_BB No

Per
Download

Subject
Information
Device Information
Session
Information

yyyy_mm_dd-
hh_mm_ss_SessionInfo.txt

No
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Per event Event Code
Event Type
Source
Event ID
Event Specific
Data

yyyy_mm_dd-
hh_mm_ss_Event_Data

No

100 Hz Vertical Accn
Lateral Accn
Sagittal Accn

yyyy_mm_dd-
hh_mm_ss_Accel

No

25 Hz Breathing
Waveform

yyyy_mm_dd-
hh_mm_ss_Breathing

No

250 Hz ECG Waveform yyyy_mm_dd-hh_mm_ss_ECGNo

1 Hz Location (Lat/
Long)
Altitude
GPS fix Quality
Speed Over
Ground
Track Angle
HDOP

yyyy_mm_dd-hh_mm_ss_GPS

* Supported GPS device
required

Yes
(displayed on
Google Maps
in OmniSense
4.0)

9.4.8.1 Enhanced Summary and Development

Format Reporting
Frequenc

y

Parameter External csv Filename Imported Into
OmniSense

Summary 1 Hz Heart Rate
Breathing Rate
Posture
Activity
Peak Acceleration
Battery %
BR Amplitude
BR Noise
ECG Amplitude
ECG Noise
HR Confidence
HRV
ROG
Device
Temperature
Status Info
Link Quality
RSSI
Tx Power
Core Temperature
Aux ADC1/2/3
Impulse Load
Walk Steps
Run Steps
Bounds
Jumps
Minor Impacts

yyyy_mm_dd-
hh_mm_ss_SummaryEnhance
d

Yes
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Major Impacts
Average Rate
Force -
Development
Average Step
Impulse
Average Step
Period
Jump Flight Time
Peak g Phi Angle
Peak g Theta
Angle

Per Event Heart R-R yyyy_mm_dd-hh_mm_ss_RR No

Per Event Breathing B-B yyyy_mm_dd-hh_mm_ss_BB No

Per
Download

Subject
Information
Device Information
Session
Information

yyyy_mm_dd-
hh_mm_ss_SessionInfo.txt

No

Per event Event Code
Event Type
Source
Event ID
Event Specific
Data

yyyy_mm_dd-
hh_mm_ss_Event_Data

No

50 Hz Vertical Accn
Lateral Accn
Sagittal Accn

yyyy_mm_dd-
hh_mm_ss_Accel

No

25 Hz Breathing
Waveform

yyyy_mm_dd-
hh_mm_ss_Breathing

No

1000 Hz ECG Waveform yyyy_mm_dd-hh_mm_ss_ECGNo
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10 Baseline Fitness Testing

The OmniSense Analysis Module can be used to generate fitness parameters, if data is
recorded during an appropriate treadmill or beep test.
· Treadmill Test
· Beep Test
· 40 Yard Dash Test
· Jump Test
· Orthostatic Hypotension Test (Resting & Standing Heart Rate)

10.1 Treadmill Test

   Zephyr recommends Fitness Test protocols be supervised under conditions
such as those recommended by the American College of Sports Medicine

(www.acsm.org)

The criteria for an effective treadmill test are:
· A constant, steady increase in workload required of the subject
· A gradual increase in both: 
o Heart Rate 

o Breathing rate

· As the Anaerobic Threshold (AT) is reached
o An associated marked increase in breathing rate 

o The heart rate should be nearing its maximum value, so rate of increase of heart rate

should be reducing.
· The subject continues with the test until they can no longer sustain the effort, at which

point 
o Maximum Heart Rate and 

o Maximum Breathing Rate has been reached.

· Recording should continue for a minimum of 30 seconds after activity has ceased, to
allow calculation of Heart Rate Recovery (HRR) values. The subject must remain inactive
during this period, for any HRR evaluation to be valid.

An idealized graph of heart rate and breathing rate during the course of such a test would
look like this:

 
To determine fitness parameters such as AT threshold from actual test data, refer to the
sections on Fitness Parameter Detection
 

http://www.acsm.org
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When using a PSM Responder system, better test results will be achieved by
using data logged internally in the BioHarness module, due to latency in

transmitting data over the radio network. Download data from the devices
directly into OmniSense Analysis

10.1.1 Treadmill Test Protocol

To conduct an AT test using the PSM Training, use a treadmill:

The test should follow an incremental exercise test such as the ACSM ramp protocol, or a
modified Conconi test, a treadmill version of which is described as follows: 

1. 10 minute warm-up, including stretches..
2. Set the treadmill gradient at 5%.
3.Set the start speed at 6kph (3.7mph).
4. Every 3 minutes, increase the treadmill speed by 2kph (1.25mph)
5. To gain maximum benefit from the test, provide verbal encouragement to the athlete

during the test.
6. The test finishes when the athlete can no longer continue.

The subject should reduce to walking or remain
stationary for 30 seconds after the test to allow a Heart
Rate Recovery measurement to be derived.

If this test is carried out using a PSM Responder system,
better data will be captured by using the devices in
logging mode, due to the latency of data transmitted
over the radio network.

Download logged data directly into OmniSense Analysis.

   Note: it is important that the above speed and timing criteria are observed, as
the automatic VO

2
max calculation is determined by the speed at which the

subject stops running – specifically the duration they have been running for.

If different speed, gradient and timing criteria are used, the VO
2
max

calculation will be less accurate.

10.1.2 VO2Max Calculation

If the test protocol is strictly adhered to, then Analysis can calculate a VO
2
Max value.

1.Detect anaerobic threshold, either automatically or manually. If an AT marker is already
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present, then the VO
2
 algorithm calculation will assign a %VO

2
Max value to it.

A marker with indicated HR and BR at AT will be set:
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2.Set  and  markers to the active section of the session - place the vertical
cursor at the start or end of the active part of the session, and mark appropriately
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3. VO
2
Max will be displayed at the maximum breathing point. The %VO

2
Max level will be

displayed at the AT marker previously placed.
An ACSM-derived formula is used for this calculation.

10.2 Beep Test

A beep test is another form of maximal performance test familiar to coaches and trainers.
Subjects run back and forth between markers to an audio cue which gradually decreases
the amount of time (and hence increases subject speed) allowed to reach the next
marker.

Although the activity is different to a treadmill test, heart rate and breathing rate data
should look broadly similar to that illustrated in for the treadmill test.

10.2.1 Beep Test Protocol

1. Place marks or cones 20 meters apart

2. Subjects should warm up and stretch for 10 minutes. 
3.When ready, with all equipment operational, and OmniSense recording, start the audio

recording to initiate the test. A sample of this recording can be found at:
https://app.box.com/s/qnpds7wby5dq2g4yh2b5ay674uadpymq

The recording generates audio cues which are equivalent to the following running speeds
between the markers:

  

   Note: Beep Test protocols vary internationally, with markers being placed 20
yards or 20 meters apart. 20-meter spaced markers represent a 9.3%
increase in distance over 20-yard spaced markers. Thus subjects using

metric-spaced markers use 9.3% more effort for a given level in the test. 

https://app.box.com/s/qnpds7wby5dq2g4yh2b5ay674uadpymq
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Likewise there are minor differences in the speed criteria for some audio
recordings available, as different researchers have fine-tuned the test.

If different distance and timing increment criteria are used, the VO2max value
will be less accurate.

 

10.3 40 Yard Dash Test

This test will populate a peak acceleration value Dg [Dash g-force] ’in the subject’s
BioGauge in the Live module, as well as record this value into the OmniSense database for
access in the Analysis module.

 
1. The subject must assume the half-crouch as shown above or full sprint crouch, and

maintain for a minimum of one second. The posture value indicated when in the crouch
position is required for the detection algorithm to initiate.

2. Start when directed and maintain sprint as required.

3.Note that other explosive activities or events which mimic the crouch posture , pause
and explosive start may generate peak acceleration values which will populate or update
the subject BioGauge Dg value, as well as record ‘Dash’ events in the database. Such
activities should be avoided, or note made of exactly when a deliberate Dash event is
attempted. Use the Marker facility in OmniSense Live if preferred.

10.4 Jump Test

This test will populate a peak acceleration value Jg [Jump g-force] ’in the subject’s
BioGauge in the Live module, as well as record this value and also Jump Height and Jump
Time In The Air into the OmniSense database for access in the Analysis module.
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1. The subject should crouch, pause, and spring as high as they can. Note that the jump

detection and calculation algorithm has been optimized for vertical jumping. It will also
be triggered during a Broad Jump event, but the data for Jump Height and Time in the
Air will be less valid.

2. The Jump Test is similar to the Dash Test in detection. Note that other explosive events
which mimic the explosive start and vertical acceleration may generate peak vertical
acceleration values which populate or update the subject BioGauge, and are also
recorded into the OmniSense database. It is recommended that you use Markers when
recording the data, to distinguish planned jump events from false detections.

10.5 Orthostatic Hypotension Test

This is a simple test to measure resting and standing heart rate, and resting HRV. These
parameters are used in OmniSense Analysis to establish a Readiness Estimate for training
athletes, when combined with other factors.

For repetition, create a Session Name in OmniSense Live labeled 'Orthostatic Test' or
similar, and label the session accordingly. The test can also be carried out using a
BioModule in logging mode, and the data imported into Analysis.
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1. Pick a quiet location with a comfortable temperature.

2. Lie down on a comfortable surface such as a bed or couch, and remain still and quiet for
9 minutes.
This will establish your resting heart rate and heart rate variability.

3.Stand up and hold a comfortable standing position for 1 minute.
This will establish your standing heart rate.
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11 Fitness Test Analysis

The Analysis module has integrated algorithms to determine Anaerobic Threshold (AT) and
Heart Rate Recovery (HRR) values from suitable fitness test data.
· Auto-detection of AT & HRR
· Manual detection & correction  of AT & HRR
· VO2Max Calculation from a treadmill test
· Saving Fitness Parameters to the OmniSense database
· Display Parameters in a Fitness Report

11.1 Automatic Fitness Parameter Detection

1.  SELECT DATA
Populate the Legend with the session containing treadmill or beep test data (drag or
double-click). 
The Sample Team contains real treadmill test data for Demo Subject 4. 

2. SELECT TREADMILL OR BEEP TEST
Select the Time Data button, and check  the Treadmill Test or Beep Test box at the
bottom of the Select Time Variables panel – this disables all the other check boxes:

 

 
The graph will automatically display three parameters:
· Heart Rate
· Breathing Rate
· Activity Level
The values table also shows these values
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3. DETECT FITNESS PARAMETERS AUTOMATICALLY

A Detect button  can be used to try and set the AT and HRR points in the data
automatically (certain criteria in the data must be met - in the event of wrong or no
AT & HRR selection, these points should be assigned manually)

 The AT and HRR indicators will be placed automatically. If the data does not display
the required characteristics for auto-detection, a dialogue will display:

 

AT and HRR points must be selected manually if this happens. The AT and HRR
parameters can then be saved to the OmniSense database.

11.2 Manual Fitness Parameter Detection

If the data recorded during a treadmill or beep test does not clearly enough display the
characteristics required to detect AT and HRR features, they may be selected manually. 

Set Anaerobic Threshold
Identify the point where there is a marked increase in breathing rate (the second
ventilatory threshold) during the latter part of the test.

Tip: Work backwards from the maximum Breathing Rate peak, and look for the first
significant inflection point (upswing) where the breathing rate remains above 40 breaths/
min. Be prepared to ignore or allow for major spikes or troughs in the breathing rate which
may be artefacts caused by non-breathing related pressure changes on the sensor.

Drag the cursor to the point where this increase shows, and click the  button. A
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new (red) cursor line will be created at the AT point.

Set Heart Rate Recovery
Relocate the cursor to the point at the end of the test (probably where activity ceases)

and the heart rate drops. Click the  button. A 30-second time interval outline will
be created.

 
If desired, the selected parameters can be saved to the OmniSense database and used in
subject fitness radar reports.
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11.3 Correcting an Automatic Detection

The human brain has sophisticated pattern-recognition algorithm that can note subtleties
in data that even sophisticated algorithms fail to detect. Developers continue to try and
emulate the brain's potential.
A user should place the vertical cursor at manually selected points using the guidelines

described below, and use the manual buttons  and  to set the detections
manually.

Here is an example of a data set where the automatic detection algorithm has - wrongly -
placed the AT threshold at the 56% VO

2
Max level:

However the human eye can see an
underlying trend in the breathing data – a
slowly increasing rate to around the 13:30
minute mark, followed by a more rapidly
increasing rate.

These trends are marked with the blue
lines.

They are masked by variations or
artefacts in the data which have caused
the algorithm to detect a false AT
threshold, too early in the test.

 An alternative approach is too look for the major upswing in breathing rate which raises it
above 40bpm and keeps it there, allowing for minor variations.

The 40 bpm level is indicated by the
horizontal line. 

The circle marks the major inflection in the
breathing rate which pushes the breathing
rate through the 40 bpm level.

The two fleeting drops below 40bpm above
the inflection should be ignored.
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Both of the approaches above indicate that the automatically-detected AT threshold
should be corrected. Drag the vertical cursor to the inflection point indicated by both the

above methods, and click the  button to manually correct the automatic detection.

The new AT threshold is now at the 80%
VO

2
Max level.

11.4 Save Fitness Parameters to Database

Click the  button. A dialogue will display – select the check boxes according to
requirements.

 

Session Detail

Values saved against that session, which will always be displayed
on the graph

Save HR @ AT and BR
@ AT:

Saves the AT vertical marker created - the markers will always be
visible on the graph for the selected session. Data is also available
as a summary variable for that session 

Save Heart Rate
Recovery:

Saves the HRR rectangle created - always visible on the graph.
Data also available as a summary variable for that session 

Save VO
2
Max: Saves the Start and End markers, along with VO

2
Max values



 164

© 2016 Zephyr Technology

Subject Data

Values saved to the database, and updated in the subject’s
physiological parameters in the Live module. They can be
displayed in Fitness Reports

Update HR Max of
User:

Updates saved details for the subject - this changes the value
which will give 100% deflection on the HR dial in the Live Module,
and sets the levels when displaying Heart Rate Percent data

Update BR Max of
User:

Updates saved details for the subject - this changes the value
which will give 100% deflection on the BR dial in the Live Module

Update BR @ AT of
User:

Updates saved details for the subject.

Update HR Recovery
of User:

Updates saved details for the subject – this stores a reference HRR
value for the user which is indicated on the HRR graph 

Update VO
2
Max of

User

Updates saved details for the subject.

Update User %
VO

2
Max

Updates saved details for the subject.

11.5 Orthostatic Hypotension Test

Carry out an orthostatic hypotenstion test, either using OmniSense Live, or using a
BioModule in logging mode, and import the data. 
See the Readiness topic.
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12 Reports

A number of fitness report options are now available. They are accessed from the tabs at
the top of the graph panel:

Training Reports

· multiple subjects
· group summary statistics
· radar plots which compare each subject against the group average values

Fitness Reports

· multiple or single subjects
· summary statistics
· radar plots which compare each subject against the group average, or a selected

population normal file, or a customized normal file created manually from historical group
data

 

12.1 Report Generation Workflow

For efficiency in generating a report, and to minimize the work involved in selecting the
correct sessions, the following steps are recommended:

OmniSense Live
See also OmniSense Live Help > OmniSense Application > User Preferences > Session
Names
1. Name the session in OmniSense Live

    
2. Session names can be created and edited in the Live > User Preferences dialogue.

   
   Customized session names specific to a particular activity will greatly simplify selecting
those sessions needed for a report.
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OmniSense Analysis
For rapid automatic population of Training Reports with larger groups, the best approach is

to filter the sessions displayed in the Select Session tree to only the team, session, and

subsessions within a certain timeframe desired to generate a report.  Once this is done, a

mouse right-click will display context menus which will auto-populate a report with only

those sessions (or subsessions) which are displayed in open nodes in the Select Session

tree. This may be the only practical way of creating a report with large numbers of

subjects:

0

Using the above Demo Subject Soccer Practice sessions as an example, there are two
ways of populating Select Session quickly.
1. Use the Session name
   

If the session name is unique, then this is all that needs to be set.
2. Use the Date Filter
    This particular session occurred 22 March 2012. Use the Date filters to select this day.
      

Use a combination of both of the above if necessary
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3.  When only those sessions wanted for the report are displayed in Select Session, then
right-click any session and select the 
     desired option from the context menu displayed.

4.  Alternatively, drag and drop those sessions wanted manually from the Select Session
tree to the report pane.

5. To remove sessions from a report, uncheck the Include in report checkbox for individual
sessions, or right-click and select Remove All Sessions
   

6.  To generate the desired report, click the Generate button

12.2 Remove Unwanted Parameters

To remove unwanted parameters from a report (e.g GPS data when not needed) - both
columns in the spreadsheet, and axes from the radar plots:
1. Export the report as an Excel® spreadsheet.
 

2. Open the spreadsheet at the SessionSummary tab. Right-click on the tab and select
Select All Sheets. This will modify the radar plots also.

 
3. Select all the columns to delete (if the A|B|C|... column headings are not displayed, go
to the View tab and check the Headings box) and delete them by right-clicking
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4. The report and radar plots can be truncated to a more usable size

 

12.3 Error Values

Cells in the Report Spreadsheet may show the value #DIV/0!. This is an Excel-generated
error indicating that a value cannot be calculated.

12.4 Training Reports

Training Reports are designed to provide analysis and display of data from groups of
subjects pursing a training program. The data is typically presented in three ways:

Summary spreadsheet of all Radar plot to compare Bar Charts of group and
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parameters for group and
individuals

individual vs. group
performance

subject Intensity and Load
values

Group Consolidated Summary A comprehensive set of parameters (42) available in
group spreadsheet format, plus individual subject
spreadsheets and radar plots for group comparison

Periodization Report Group spreadsheet focussing on Physiological,
Mechanical & Training Intensity and Load data. Group
Load & Intensity bar charts, and the same for each
subject

Summary GPS Group spreadsheet showing time and distance  by speed
zone, average and max speed, elevation change &
distance traveled. Subject radar plots of same for group
comparison

Summary Physiological Group spreadsheet of heart rate-related  and core
temperature parameters, plus individual radar plots for
group comparison

Workout Compliance Group spreadsheet focussing on intensity, load, and time
in Workout Zones, defined in the OmniSense Live module
preferences dialogue

Generate A Report
1. Populate the report pane with the required sessions according to the workflow
recommendations
2. Click the Generate button and select report type from context menu

 3. For detailed analysis, better display, and to remove unnecessary columns, export the
report to an Excel .xlsx spreadsheet using the Export button
    (Microsoft® Excel required)
    

12.4.1 Group Consolidated Summary

The consolidated report is a comprehensive report containing all data for the group in
spreadsheet form as well as individual subject spreadsheets and a radar plot:
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Individual subject radar plot:

In many scenarios this report may present too much data. It should be exported as an
Excel® spreadhseet and columns removed to suit. e.g GPS data columns can be removed,
as well as the corresponding axes in the subject radar plots.

Parameter Description Also in

Session & Subject names,
Start Date/Time, Duration

All reports

% Time > 85% HR
max

Summary Physiological
Report

% Time 65 - 84% HR
max

Summary Physiological
Report

% Time < 64% HR
max

Summary Physiological
Report

% Time > HR@AT % Time above anaerobic
threshold

Summary Physiological
Report

% Time < HR@AT % Time below anaerobic
threshold

Summary Physiological
Report

Peak HR Modify the subject's stored Summary Physiological
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HR
max

 if this value exceeds it Report

Average HR Summary Physiological
Report

Average & Max HRV (SDNN) Heart Rate Variability -
Stress indicator

Summary Physiological
Report

Average & Max HRR Heart Rate Recovery -
Fatigue indicator

Summary Physiological
Report

Average Core Temperature Summary Physiological
Report

Maximum Core Temperature Summary Physiological
Report

Total Calories burned Using ACSM formula Summary Physiological
Report

Physiological Intensity &
Load

Heart Rate based indication
of workout performance

Periodization Report
Workout Compliance Report

Mechanical Intensity & Load Acceleration based indication
of workout performance

Periodization Report
Workout Compliance Report

Training Intensity & Load Average of the above two Periodization Report
Workout Compliance Report

Time in Blue/Green/Yellow/
Orange/Red
Zones

HR based Training zones,
configured in OmniSense Live
> Preferences

Summary GPS Report
Workout Compliance Report

Time in Speed Zone
1/2/3/4/5/6

GPS data - Speed zones
configured in OmniSense Live
> Preferences

Summary GPS Report

Distance in Speed Zone
1/2/3/4/5/6

Summary GPS Report

Average & Max Speed Summary GPS Report

Elevation Climb & Descent Summary GPS Report

Total Distance Summary GPS Report

12.4.2 Periodization Report

This report focuses on the intensity and load parameters, and should be used as an
overview to reveal any over-or under-training tendencies:
The parameters are listed in the table in the Group Consolidated Summary.
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Group summary - data & stats in table
format, plus bar chart (single session only

displayed)

Individual subjects reports

This type of report is most useful in displaying long-term training data over multiple
sessions, to establish any over- or under-training trends.
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12.4.3 Summary GPS Report

This report focuses on the speed & distance parameters; the BioHarness must be
accompanied by a supported Bluetooth GPS module, and configured to communicate with
it. This process is described in the OmniSense Live Help > GPS > Support topic. No
physiological parameters are included.
The parameters are listed in the table in the Group Consolidated Summary.

Group summary - data & stats in table format

Group summary - data & stats in table format, plus radar plot

12.4.4 Summary Physiological Report

This report focuses on the physiological  parameters only.
The parameters are listed in the table in the Group Consolidated Summary.
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Group summary - data & stats in table
format

Individual subject table with group averages,
plus radar plot

12.4.5 Workout Compliance Report

This report focuses on load, intensity, and the times in the Periodization workouts, if they
have been activated during a session in the OmniSense Live module. Details are included in
OmniSense Live Help > OmniSense Application > Live operation > Training % Workout Tabs
The parameters are listed in the table in the Group Consolidated Summary.

Group summary - data & stats in table
format

Individual subject table with group averages,
plus radar plot

12.5 Fitness Reports

Fitness Reports are designed to provide analysis and display of data from groups of
subjects pursuing a training program.
The data is gathered from three tests:
· Treadmill Test

After Analysis of a Treadmill Test, the user is prompted in a dialogue whether fitness
parameters are to be updated in the OmniSense database:
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· Orthostatic Hypotension Test (Resting and Standing Heart Rate)
Data is entered manually into the subject parameter table in OmniSense Live after the
test has been performed.

It is typically presented in three ways:

Summary spreadsheet of all
parameters for individual or a

team

Radar plot to compare
individual or team vs.

normative performance

Bar Charts of team and
individual Intensity and Load

values

· Individual Fitness
Report

Report of an individual subject chosen by name

· Team Fitness Report Group fitness parameters, with outliers indicated, from a specific
team selected by the user

3. For a Team Fitness report
a. Select the team from the pulldown list
b. Use Select Team to populate the table below
c. Click the Chart button
d. Export the data to an external Excel file for easier viewing

12.5.1 Individual Fitness Report

A individual Fitness Report contains parameters, and where they are sourced from:

VO
2
max Saved from Analysis of a Treadmill Test

Percentage VO
2
max at Anaerobic

Threshold (AT)

Saved from Analysis of a Treadmill Test

Heart Rate Max Saved from Analysis of a Treadmill Test
Can be updated manually in OmniSense Live >
Subject parameters

Heart Rate @ AT Saved from Analysis of a Treadmill Test
Can be updated manually in OmniSense Live >
Subject parameters

HR @ AT as % of HRmax Saved from Analysis of a Treadmill Test

Breathing Rate @ AT Saved from Analysis of a Treadmill Test
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Can be updated manually in OmniSense Live >
Subject parameters

Heart Rate Recovery Saved from Analysis of a Treadmill Test

Min Heart Rate Standing Entered manually in OmniSense Live > Subject
parameters

Min Heart Rate Resting Entered manually in OmniSense Live > Subject
parameters

Analysis has the capacity to generate a radar plot of a variety of fitness parameters
which can be derived from saved fitness test data:
 

Generate A Report
1. In the right-hand panel of Analysis, select the Fitness Reports tab. Individual Person is
checked by default.

2. Choose  Select Normative - a normative file is a set of summary fitness parameters
pertaining to a particular subject type, for for baseline fitness comparison. Zephyr
provides sample data for:
· Fire Fighters
· Military Special Forces
· Soccer players
· College basketball players
The files  are located at My Documents\OmniSense\Physiological Normative.
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Any of these files can be cloned and customized with your own team data as a baseline.

3. When a normative file is selected, the report panel will populate with the normative
data for inspection. 

Select the desired subject from the Subject pulldown
 
4.  The panel will repopulate with the selected subject's data
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Then select the Chart button to display the report.

5.  The full report can only be displayed in a very large screen. For easier viewing, click
the Export button at top right to create an Excel® Spreadsheet of the Report. Microsoft
Office or Excel must be installed on the PC for viewing.     

6. The report comprises two parts - a table of summary data for the subject
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7. The second part is a radar plot of the subject vs. the normative data

 If a parameter is not available, or is not entered manually into the table which generates
the plot, then the axis representing that parameter is omitted from the generated plot.

8. Each graph axis is scaled differently - it represents a bell curve of a theoretical group
extrapolated from the normative file. The midpoint of each axis is the average of the
normative data, indicated by the edge of the blue polygon. Inside and outside the
polygon, the axes are three standard deviations in range. Thus the center point of the
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plot does not represent zsero for any parameter, but the lowest expected value in a
normal population sample.

12.5.2 Team Fitness Report

1.Select Fitness Reports tab
2.Select Team button
3.Select Team
4.Click Select Team button
5.Click Chart to see chart
 
 
Group reports differ from Individual Fitness Reports which show individual subject fitness
parameters.

Cells are color-coded:
Yellow more than one standard deviation below the group mean. This threshold value
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for each parameter is the 'SIGNIFICANTLY LOW' value

Green within one standard devia tion of the group mean

Red more than one standard deviation above the group mean. This threshold value
is the 'SIGNIFICANTLY HIGH' value

 Report Data

VO
2
max Saved from Analysis of a Treadmill Test

VO
2
max % VO

2
max at AT Saved from Analysis of a Treadmill Test

HRmax Saved from Analysis of a Treadmill Test

HR at AT Saved from Analysis of a Treadmill Test

HR at AT as %HRmax Saved from Analysis of a Treadmill Test

BR at AT Saved from Analysis of a Treadmill Test

Heart Rate Recovery (30
second)

Saved from Analysis of a Treadmill Test

Min Heart Rate Standing Entered manually in OmniSense Live > Subject parameters

Min Heart Rate Resting Entered manually in OmniSense Live > Subject parameters

Min Breathing Rate Resting Entered manually in OmniSense Live > Subject parameters

HRV ar rest Entered manually in OmniSense Live > Subject parameters

Fitness Level (Active)

Fitness Level (Resting)

Fitness Level (Combined) Arithmetic Mean of the above two

 Fitness Levels are indicated in a bar chart below the summary table.  

As separate tabs in the Excel worksheet, individual subject fitness reports are displayed
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As well as individual subject radar plots. The Blue polygon represents the team mean
(normative) value for each fitness parameter. If a subject's red outline lies inside the
polygon, then they have lower values than the group mean. 

12.5.3 Customizing A Normative File

As individual team members perform fitness tests and baseline data is created for their
fitness parameters, then this baseline data can be used to create a further normative file
for subsequent comparisons against the team baseline.

1. Follow the steps to create a Team Fitness report using any of the Zephyr-supplied
Normative fitness files.
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2. This will supply your team's average and standard deviation for all the fitness
parameters.

3. Go to the location in .../My Documents/OmniSense/Physiological Normative directory,
and copy any normative file and rename it with your team's name.

4. Open the new normative file, and replace the data in the Normative and Standard
Deviation data from  your team's report.
   Thus the Normative = 39 and Standard Deviation = 7.25 in the top VO2max row of the
diagram below should be replaced
   with Average = 52.38 and Standard Deviation from the Team Summary report in the top
diagram. Repeat this process for each fitness parameter.
  In this manner the team's own normative file, which is a snapshot of their fitness levels
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at the time the Team Fitness report was created, can be 
  used as a baseline to establish the team's fitness progress over any period of time.

    Do not change any other field in the Normative file - though the first cell is a comment
- retain the '##' at the beginning and add a new description if desired.
    Ignore the existing data in the Zephyr Normative file to the right of the Normative and
Standard Deviation columns.
5. When the data from the Team Fitness Report is inserted into the Team Normative, it will
look like this:

    This normative file can be used for all subsequent team fitness reports.
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13 Fitness Parameters

A number of Fitness Parameters are calculated in the BioHarness device, or in OmniSense
itself:
· VMU - Vector Magnitude Units, measure of activity level
· Calories - a measure of energy expenditure
· VO2 Max -  maximum oxygen uptake, a measure of physical

capacity

EPOCH
A number of these parameters are calculated over an epoch. An epoch is an interval of
time, rather than an instantaneous point. Data is sampled multiple times during the epoch,
and the samples used to calculate the parameter. 

For example, Peak Acceleration is sampled 100 times each second, but Peak Acceleration
is reported once per epoch - the maximum value recorded.

VMU is a measure of activity calculated using all of the acceleration values recorded
during an epoch.

13.1 VMU

Vector Magnitude Units (VMU) are used to indicate activity level. They are expressed in 'g'

- units of gravity, 9.81m/s2

· 0.2g - roughly equivalent to a walking level of activity
· 0.8g - roughly equivalent to a running level of activity

The BioHarness contains a 3-axis accelerometer which can record values of ±16g in the X
(subject vertical), Y (subject lateral), or Z (subject sagittal) axes. The data is sampled at
100Hz, and these sets of samples used to calculate

    

2 + y2 + z2) calculated for each
sample point during the epoch.

13.2 Calories

A calorie is a measure of energy expenditure. The epoch for calorie calculations is 30
seconds.

    
Where Cal

e
 = Gender * (-55.0969 + 0.6309*HR + 0.1988*weight + 0.2017*age) + (1 -

Gender) * (-20.4022 + 0.4472*HR – 0.1263*weight + 0.074*age)

HR = average heart rate for epoch
Weight = Subject weight in Kg
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Age = Subject age in years
Gender= 1 for male, 0 for female

This formula is derived in the paper Keytel L.R, Goedecke J.H, Noakes T. D, Hiiloskorpi H,
Laukkanen R, Van Der Merwe L and Lambert E.V. 2005, Prediction of energy expenditure
from heart rate monitoring during submaximal exercise Journal of Sports Sciences  23(3)
289 – 297

13.3 VO2Max

VO2 Max is an estimate for maximal oxygen uptake. It can be calculated automatically in
OmniSense from data obtained during a maximal fitness treadmill test. The test protocol
must be strictly adhered to, including the gradient settings on the treadmill, as an ACSM-
derived formula is used.

It is measure in milliliters per minute per kilogram.

VO
2
max = 0.869 * (3.5 + (0.2 * v)) + (V * grade * 0.9) - 0.07

V = velocity in meters per minute
Grade = Constant 5% (0.05)

For a 21 kph top speed, this formula would give 77.48 ml/min/kg
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14 Impact Processing

Accelerometry Overview - a summary of accelerometer data available in Analysis
Impact Overview - Introduction to Impact Analysis

To collect impact data, the following tasks must be performed

1. Configure the BioModule to Summary and Waveform logging format
2. Download logs from BioModule
3. Use Impact Processor Tool

Analyzing the data

14.1 Accelerometry Overview

The BioHarness module contains a 3-axis accelerometer which samples at 100Hz over the
range ±16g. This data allows posture and activity data to be analysed. The graphs below
show the data available for display in the Analysis module using a simple exercise -
jumping from a 3 foot wall down to a hard surface on three occasions to show three clear
(vertical) impact events.

ACTIVITY LEVEL

This is measured in Vector Magnitude Units
(VMU) and reported once per second. It
uses the average acceleration in each axis,
over the 100 samples, in the previous
second.

Maximum VMU is 0.85 in this example

It is available in all PSM systems.

PEAK ACCELERATION

This is measured in g and reported once per
second. It uses the peak acceleration in
any one single axis, of the 100 samples, in
the previous second.

Peak Acceleration is 7.95 g in this example.

The value is always positive.

It is available in all PSM systems.
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ACCELEROMETRY

This is measured in g and reported at 50
Hz. Raw accelerometer data is shown - the
effect of gravity is not filtered out.

The minimum value is -10g in the vertical
axis.

This data is only available in PSM Training
Systems using Bluetooth direct to the PC,
or PSM Responder systems, for a single
selected BioModule in use at any one time.
It is not available in PSM Training ECHO
systems.

Although each of the three graphs above clearly show three major impacts, quantitative
comparison of the impacts is not easy. Once meaningful data is collected in a session
containing many large and small impacts, it becomes even harder to extract meaningful
comparisons from this raw data.

For this reason Zephyr have embedded impact analysis  functionality into OmniSense
Analysis.

14.2 Impact Overview

The BioModule, if configured appropriately, can log the accelerometer data at 100Hz.
The same three impacts illustrated in the overview, of jumping onto a horizontal surface
are shown here.

ACCELEROMETER MAGNITUDE

This is calculated using the formula

g
2 + L

g
2 + S

g
2) where V

g
, L

g
 and S

g
 are

three axis components of acceleration
(Vertical, Lateral & Sagittal). This gives a
single accelerometer parameter instead of a
separate value for each axis.

Data from the Accel file from the Summary
and Waveform logging format is used.

Two factors gauge how severe an impact is
to the wearer:

1. The maximum value of accelerometer
magnitude

2.How long the impact lasts (this will be
milliseconds)
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To analyse an impact in detail, this graph
shows only the first of the three impacts in
an expanded view. The dots show individual
samples at 100Hz.

The maximum value of accelerometer
magnitude is 8.4g

To gain a metric which includes how long
an impact lasts, we measure the shaded
area under the curve. In this instance, we
are measuring only the duration where the
impacts exceeds 2g. This causes the
impact to be split into two separate events
- impact & rebound.

The area under the graph is measured in gs
(g-seconds)

Zephyr's Impact processor tool
automatically analyses the accelerometer
magnitude data and produces a new data
set, with two major values for each
detected impact:

· Peak g (red outline)
· Area in g-seconds (solid red)

The user must select the lower cut-off g
value above which to measure area (this
filters out 'noise' caused by foot impacts,
etc.

The tool also segregates the impacts into 
configurable zones of severity (e.g. above
2g, above 4g, above 6g etc) and counts
the total number of impacts in each zone.

This allows a coach or research to gauge 
how many impacts, and how severe, a
wearer is subject to in any session.

14.3 Gathering Impact Data

Configure the BioModule - set the required logging format using the Zephyr Cfg Tool
Download Logs - use the Zephyr Download Tool or Log Downloader to create the
necessary external csv files needed for the Impact Processor
Impact Processing Tool - process the log files

14.3.1 Configure the BioModule

BioModules are normally configured to log data, in the default Summary Log format. This
collects all major parameters at 1 second intervals. To analyse impact data, accelerometer
data should be logged at 100Hz. This is done by reconfiguring the BioModule to log in 
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Summary and Waveform format, using the Zephyr Cfg Tool, which is installed automatically
when OmniSense is installed.

1.  Connect your BioModule to the PC in its charge cradle.
2.Go to C:\Program Files (x86)\Zephyr\OmniSense\Tools or use the Windows Start menu

3.Open the tools directory and locate the Zephyr Cfg Tool.exe. Click and start the tool.
4. Select your BioModule by its serial number from the Device Selection pull down.
5.Go to the User Config tab, and change the Log Format to Summary and Waveform. 

   

Changing the Log format will erase all logs already existing in the device.
Download any logs you do not wish to lose, using either the Zephyr Downloader

Tool first to save data into the Analysis database, or the legacy Log
Downloader tool to save data as external csv files (you will not be able to
import this external data back into the OmniSense database afterwards)
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Note that changing log format to Summary and Waveform will greatly increase
the size of any single log session. This will increase the time taken to download

a log.

14.3.2 Download Logs

The 100Hz logged accelerometer data which is used for impact analysis is not stored in
the OmniSense database. 
It is stored in an external csv file located in a sub-directory in ...My Documents
\BioHarness Test Logs.

This file can be generated by either the Zephyr Downloader accessed from the Analysis
toolbar, or the legacy BioHarness Log Downloader Tool located in C:\Program Files (x86)
\Zephyr\OmniSense\Tools

When using the Zephyr Downloader accessed from Analysis, make sure that the Write CSV
Format Log Files is checked in the Options menu.
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This will ensure that the Accel file required for Impact Analysis is deposited in ..My
Documents\BioHarness Test Logs.

When using the Legacy BioHarness Log Downloader tool, ensure that logs are saved as All
Formats or CSV Format.
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14.3.3 Impact Processing Tool

Start the Impact Processor tool using the  Impact Processor button in the Analysis
toolbar.

· When the tool is started, it will automatically search the default ..My Documents
\BioHarness Test Logs folder for any YYYY_MM_DD-hh_mm_ss_Accel.csv files which it
has not previously processed, and display them as a list
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· Only files not previously processed will be displayed in the Impact Processor dialogue
· Choose the type of processing and output from the File menu option:
    - Open Manually - opens a dialogue to allow you to browse for a specific ...Accel file
(say not in the default location) and open it
    - Process All Unprocessed Files - will automatically processed all files listed and
generate default csv IMPACTS files
    - Generate Accel Pro Report - check to generate an Excel spreadsheet (Microsoft®
Excel 2010 or later to be installed on PC) with color-coding and graphs
· Then set the configuration of the tool - the zones into which it will divide and counts

impacts, according to peak g. Select Edit > Preferences from the tool's menu.
This dialogue shows the default settings.

You can customize the Impact Exposure Range limits or leave the defaults initially to
how your activity is represented using the default values.
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· Click Process to process the raw acceleration data
The output csv file or Pro Report is deposited in the same directory as the other files
created by the Zephyr Downloader or BioHarness Log Downloader

14.3.3.1 Impact Exposure Ranges

Configure the Tool using the Edit > Preferences menu option. The Impact Processor will
categorize impacts by severity into five separate Exposure Ranges 1-2-3-4-5. 

The settings are:
· Lower limit Start for each Exposure Range
· Impact Baseline Limit - ignore values below this absolute value when calculating impact

parameters such as duration, rise time
· Impact Peak Limit - minimum g value for an impact to be counted

This graph explains the zones in context of the raw accelerometer magnitude data.
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Every upper spike in the (red trace) raw accelerometer magnitude data could be
categorized as an impact. The majority fall below the grey  Impact Baseline Limit of 1.5
g. 

This graph shows how they will be counted in the Impact Data output file.
· 5 impact rebounds in Exposure Range 1
· 1 major impact in Exposure Range 4
· 2 major impacts in Exposure Range 5
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Users can fine-tune the Exposure Range limits to suit their data.

14.4 Analysing Impact Data

There are two processing options:
· Default csv file Filetitle_yyyy_mm_dd_hh_mm_ss_IMPACTS.csv
    - comma separated values format
    - itemizes impacts as categorized by the Impact Baseline Limit and Impact Peak Limit
parameters set in the Preferences dialogue of the Impact Processor Tool 
    - impact duration
    - count of impacts in each Exposure Range
    - direction of impact
    - count of up/down, left/right, forwards/backwards impacts
    - list of X/Y/Z accelerometer samples
· Pro Impact Report Filetitle_yyyy_mm_dd_hh_mm_ss_AccelPro.xlsx
    - Microsoft® Excel .xlsx format - PC must have Excel 2010 or later pre-installed
    - itemizes impacts as categorized by Impact Baseline Limit and Impact Peak limit
parameters as above, 
      Additional parameters:
          - left/right, front/back, above/below indication
          - Load/Impulse Load
          - Total Peak Load
          - Average Force Development
          - Average Peak g
          - Average Impulse
          - Average Period
          - Average Flight Time
          - Histogram display of X/Y/Z 100 Hz accelerometer stream
          - Angles of impact direction (Phi & Theta)
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14.4.1 Default csv Impact File

The Impact Processor outputs a .csv file labeled as with the following table of data.
This file can be opened in Microsoft® Excel. The color has been added afterwards for
clarity.

The parameters are:

Timestamp resolution down to milliseconds. Configure using Excel

Impact Number The bottom value shows the total impact count

Rise Time How fast or slow the impact initiated

Area (gs) Index of impact severity which integrates g over total impact duration.
These metric is replaced by the Impulse Load which is measrued in SI
units of Newton seconds in the Pro Impact Report

Peak g Maximum deceleration occurring during impact

Impact Length Duration of Impact above lower limit of Exposure Range lower value

Exposure Range
Counts

Cumulative totals of impacts per Exposure range. The final totals are the
bottom values in each column

Direction of
Impact

Up/down, Left/Right, Forwards/Backwards - from the subject's point of
view i.e. an 'Up' impact means the subject landing after a jump - the
landing surface is 'hitting' the subject in an upwards direction

Positive/
Negative
Vertical/
Lateral/Sagittal
Counts

A cumulative total - the final totals are the bottom values in each
column

Vertical
Lateral/Sagittal
Profiles

Lists of semi-colon separated values of the Accelerometer samples.
These are not formatted for easy analysis - a better option is to have
checked the Pro Impact Report which will show graphical analysis of the
data

The cumulative counts of impact will characterize any particular session in terms of impact
severity - this short sample data set contains only three major impacts.



 202

© 2016 Zephyr Technology

Peak g and area (gs) show the severity of individual impacts.

Combining the two shows that the initial major impact incurred a smaller peak g than the
two following, but it lasted longer (The black outline showing Area)

14.4.2 Pro Impact Report

· To generate a Pro Impact report, the PC being used must have Microsoft Excel® 2010
or later installed.
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· Check the Pro Accel Report option in the Impact Processor Tool menu options
· The generated Excel® spreadsheet will be saved into the same directory as the Accel

csv file which was used as source, default C:\Users\...\Documents\BioHarness Test Logs
\...

· The spreadsheet has three tabs:
     - Summary
     - Impulse Data Lines
     - Accelerometry stream

14.4.2.1 Summary

The Summary tab provides an overview of impact events, categorized by type. A type is
either:
· an Impact - a change in momentum causing a detectable acceleration or deceleration of

the BioModule
· a Step - a change in momentum caused by one of the step types below.

- walking step
- running step
- bounding step
- jump

Zephyr proprietary algorithms analyze the accelerometer samples and categorize changes
in momentum as Impacts, or Steps of the various types. The data is analyzed for the
direction, magnitude and regularity of the momentum changes. Rotational changes can
infer whether a step is on the left or right side. The time period between steps can be
used to determine step type - running steps are faster than walking, etc. Averages are
determined over a number of steps of similar type. Jump flight times can be calculated
once the takeoff/landing signature of the jump has been established.
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Impact Parameters
Categorized by Impact Zone

Parameter Units Description

Zone # Count Number of impacts
detected per Exposure

Range (Zone)

The number of impacts in the 1/2/3/4/5
Impact Zones as configured in the 
Edit>Preferences               menu option of the
Impact Processor tool

Zone # g Load g The sum of the Peak g values for each impact
in the given category

Zone # Impulse
Load 

Newton seconds A summation of the accelerometer magnitude
samples for the  impulse expressed in SI units

Left/right, front/
back, above/
below

Direction from which the impact has come i.e.
a landing after a jump is indicated as an
impact from below

Total Count Total number of impacts
detected

The total number of impact events in each
given category

Total Peak g
load

The total Peak g Load of events categorized
as above

Total Impulse
Load 

Newton seconds The total Impulse Load of events categorized
as above

Summary Parameters
Categorized by Impact Type

Parameter Units Description

Average Force
Development 

Newtons per second Average of all events in each walking/running/
bounding/jumping type

Average Peak g g Average Peak g of all events categorized as
above

Average Impulse Newton seconds

Average Period Seconds Average step time

Max Flight time Seconds Maximum time in the air of all jump events

Average L
period/average R
period

Seconds Average L/R step time
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14.4.2.2 Impulse Data Lines

Each Impact Event contributing to the Total Count in the Summary tab is itemized as a
data line in this tab.

Time of Peak Each entry is a hyperlink to the relevant lines in the 
Accelerometry Stream tab

Magnitude g Peak g for that impulse event

Impulse Load See diagram below

Duration See diagram below. The duration of the impulse will dictate
the number of lines selected from the Accelerometry Stream
when following the hyperlink for that impulse

Rise Time See diagram below

Fall Time See diagram below

30ms Rate of Force
Development

See diagram below

30ms Rate of Force Decline See diagram below

Time Since Last Peak Time duration since the peak of the last detected impact or
step

Phi Peak Angle in vertical plane of impact peak. See Impact Angle
diagram

Theta Peak Angle in horizontal plane of impact peak. See Impact Angle
diagram

Classification Step or Impact

Type Impact Zone or type of step

Orientation If an impact, the direction from which it came

The diagram below illustrates some terminology. All impacts are characterized by a rise,
and then a fall in Peak g. Events occur above the configurable  Impact Baseline Limit for
peak g set in the Edit>Preferences menu option of the Impact Processor Tool, default
1.5g. At least one sample in the event must exceed the configurable Impact Peak Limit,
default 2g
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· Impact peak - location of maximum Peak g value, which can also be expressed in
Newtons/Kilogram, using the subject's weight.

· Rise Time - duration of all samples above Impact Baseline Limit before impact peak
· Fall Time - duration of all samples above Impact Baseline Limit after impact peak
· Impulse Load - area (yellow) under the curve. This gives a measure of impact taking into

account both the severity and duration of the impact
· Rate of Force Development - a measure of how rapidly the impact occurs -  'hard' or

'soft' it is
· Rate of Force Decline - a measure of how rapidly the impact forces decline
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14.4.2.3 Accelerometry Stream

Parameter Units Description

Time hh:mm:ss.00 Timestamp of Hz accelerometer data
sample

Vertical g g Vertical 3-axis g component

Lateral g g Lateral (subject side to side)

Sagittal g g Sagittal (subject front to rear)

Magnitude g g Square root(x2 + y2 +z2)

Phi Rad Degrees See Impact Angle

Theta Rad Degrees See Impact Angle

Instant Rate of
Force

Newtons per second

Impulse Newton seconds

14.5 Impact Angle

Analysis of the X, Y & Z accelerometer components can determine the direction from
which the impact event has come. 
This is indicated by two angles, measured in degrees:
· Theta - angle in the horizontal plane. Subject's straight ahead = 0. From subject's right

is a positive value, from subject's left is negative.
· Phi - angle in the vertical plane. Vertically upwards = 0. Impact angle  from in front of

subject is a positive value, impact angle from behind subject is negative.
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This example shows an impact from the subject's 10 o'clock position, angled from above
the horizontal plane.
Theta is negative (from subject's left), Phi is positive
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15 Troubleshooting

This topic will be expanded as issues are reported.

Skin Temperature
· In a General log file, Skin Temp = -3276.8 Deg C
The BioHarness 3.0 does not support Skin Temperature in the General Log file, so the
'Invalid' value of -3276.8 is used. Configure the device using the Zephyr Config Tool - a
description is included in the Live module Help file - to Log in Summary Format instead.
Summary format includes an Estimated Core Temperature parameter, which the BioHarness
3.0 supports.

No Data appearing under a Team listing
If this is an ECHO system, check that the BioHarness internal clocks are synchronized to
current time. Help for OmniSense Live describes the Zephyr Config Tool used to configure
this. If a BioHarness does a hard reset, its internal clock will default to Jan 1 2010 - it may
be useful to adjust the session filters to display any sessions with this timestamp.

No Logs Found on the BioHarness
To see all the logs on the BioModule, regardless of what dates they are timestamped with,
use the legacy BioHarness Log Downloader.exe located at C:\Program Files(x86)\Zephyr
\OmniSense\Tools

Markers placed during Live Session are not visible in Analysis
The BioModule clocks are out of synch with PC time. BioModule clocks will drift over time if
not resynchronized regularly by using the Zephyr Config Tool (instructions in Live Help) or
connecting them to a PC and opening the Zephyr Downloader from Analysis - this action
will resynchronize the BioModule clocks with PC time automatically.
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